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0
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Qw Tốc độ bóc vật liệu mm
3
/s 

 Hệ số truyền nhiệt của vật liệu gia công (Kcal/cm.g. độ). 

α Hệ số khuếch tán nhiệt của vật liệu phôi W/m
2
.s 
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3
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PHẦN MỞ  ĐẦU 

1. Tính cấp thiết của đề tài 

Trong gia công cơ khí, mài là phương pháp gia công có khả năng đạt độ chính xác, độ 

nhám bề mặt cao và có khả năng gia công được các loại vật liệu có độ bền, chịu nhiệt và độ 

cứng cao. Vì vậy, mài được sử dụng rất phổ biến trong ngành chế tạo máy. 

Mài thường được chọn là nguyên công gia công tinh lần cuối các bề mặt quan trọng. 

Các bề mặt cho nguyên công mài có lượng dư rất nhỏ. Vì vậy, mài ảnh hưởng trực tiếp đến 

chất lượng bề mặt chi tiết gia công cũng như độ chính xác của chi tiết gia công.  

Với các phương pháp gia công cơ như tiện, phay, bào, khoan… thì nhiệt cắt được 

truyền chủ yếu vào dụng cụ cắt và dung dịch trơn nguội, nhưng đối với phương pháp mài thì 

nhiệt cắt lại chủ yếu truyền vào chi tiết gia công. Do vậy, nhiệt độ vùng cắt khi mài ảnh hưởng 

rất lớn đến các thông số công nghệ cũng như các chỉ tiêu kinh tế - kỹ thuật. 

 Nhiệt độ khi mài ảnh hưởng lớn đến chất lượng bề mặt gia công, làm thay đổi cấu trúc 

lớp bề mặt, làm giảm độ cứng bề mặt do lớp bề mặt bị tôi lại, gây cháy nứt, biến dạng, ứng 

suất dư kéo... Đặc biệt, khác với các phương pháp gia công khác, nhiệt cắt khi mài rất cao. 

Ngoài ra, nhiệt cắt còn làm giảm độ chính xác kích thước cũng như độ chính xác hình 

dáng hình học của chi tiết gia công, giảm tuổi bền và tăng độ mòn của đá mài, lực cắt.  Nhiệt 

độ vùng cắt khi mài còn làm biến chất dung dịch trơn nguội làm ảnh hưởng đến các chỉ tiêu 

kinh tế. Chính vì vậy mà các nghiên cứu về nhiệt cắt trong quá trình mài là thực sự cấp thiết. 

Vậy nguyên nhân nào dẫn đến làm tăng nhiệt độ vùng cắt khi mài?  

- Quá trình mài là quá trình cắt gọt vật liệu bằng các hạt mài có độ cứng cao. Các hạt 

mài có kích thước rất nhỏ, có hình dáng rất khác nhau và phân bố lộn xộn trong chất dính 

kết. Đa số các hạt mài có nhiều lưỡi cắt, có góc lượn ở đỉnh và có góc cắt không thuận lợi 

cho điều kiện cắt gọt: góc trước  thường âm và góc cắt  thường lớn hơn 90
0
. 

- Tốc độ cắt khi mài rất cao ( 30m/s, mài cao tốc có thể tới 120m/s hoặc cao hơn). 

- Khi mài, mỗi hạt mài tạo ra một phoi riêng biệt có kích thước rất nhỏ (vài m đến vài 

chục m), số lượng phoi được tạo ra trong một đơn vị thời gian rất lớn (hàng nghìn phoi trong 
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một phút) vì thế có thể coi quá trình mài là quá trình cào xước tế vi bề mặt gia công tạo ra độ nhẵn 

bóng và độ chính xác cao. 

- Do quá trình mài coi như quá trình cào xước tế vi bề mặt gia công, do góc cắt không 

hợp lý, tốc độ cắt cao nên nhiệt độ ở vùng cắt khi mài rất lớn (1000 ÷ 1500
0
C) làm thay đổi 

cấu trúc tế vi lớp kim loại bề mặt.  

Đo nhiệt độ khi mài là một quá trình phức tạp vì nhiệt độ ở vùng tiếp xúc giữa đá mài 

với chi tiết gia công rất lớn (khoảng 1000 ÷ 1500
0
C), thời gian tác dụng để phát sinh nhiệt rất 

ngắn (1.10 
-4
  5.10 

-6
 s) sau đó nhiệt lại giảm xuống nhanh chóng. 

 Hiện nay trên thế giới có nhiều công trình nghiên cứu khoa học nghiên cứu về các 

phương pháp xác định nhiệt độ mài, thường sử dụng 2 phương pháp xác định nhiệt cắt khi mài 

như sau:  

- Phương pháp xác định nhiệt cắt bằng các công thức thực nghiệm. 

- Phương pháp đo bao gồm hai phương pháp sau: 

+ Đo không tiếp xúc: Sử dụng kỹ thuật quang học, sợi quang học. 

+ Đo tiếp xúc trực tiếp: Kỹ thuật phủ lớp kim loại có điểm nóng chảy thấp, sơn cảm 

biến nhiệt hoặc gắn cặp nhiệt vào đá mài. 

Tuy nhiên, các phương pháp xác định nhiệt mài như trên thường không đủ độ tin cậy, 

các kết quả đo ổn định hoặc sai khác nhiều so với các nghiên cứu lý thuyết. Do vậy, cần thiết 

phải có một phương pháp đo đủ độ tin cậy để có thể đánh giá một cách tương đối chính xác về 

ảnh hưởng của nhiệt mài. 

Đá mài CBN (Cubic Boron Nitrit) được tổng hợp ở nhiệt độ 2000 – 3000
o
K dưới áp lực 

110 – 140 bar, có độ cứng, độ bền, khả năng chịu mài mòn cao và đặc biệt giữ được cơ tính ở 

nhiệt độ cao. Đây là loại đá mài có nhiều ưu điểm so với các loại đá mài khác như: đá mài oxit 

nhôm, các bít silic…..Trên thế giới, đá mài CBN đã được nghiên cứu và ứng dụng rất hiệu quả. 

Tuy nhiên, ở Việt Nam các nghiên cứu ứng dụng đá mài CBN vào sản xuất chưa nhiều. 

Thép ШХ15 thuộc nhóm thép ổ lăn và thường được dùng để chế tạo các chi tiết máy 

chính xác, chịu mài mòn. Đây là mác thép được sử dụng khá phổ biến trong sản xuất và có 

ứng dụng rộng rãi công nghệ mài. Đá mài CBN đang được nhiều nhà máy cơ khí ở Việt Nam 
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sử dụng. Những nghiên cứu về mài sử dụng đá mài CBN mác thép ШХ15 sẽ cho phép áp 

dụng kết quả vào sản xuất góp phần nâng cao hiệu quả kinh tế - kỹ thuật của nguyên công mài.  

Vì vậy, đề tài “Nghiên cứu về nhiệt mài khi mài thép ШХ15 bằng đá mài CBN” được 

chọn lựa để nghiên cứu nhằm tìm ra phương pháp xác định nhiệt đủ độ tin cậy và những ảnh 

hưởng của nhiệt tới các thông số công nghệ mài. 

2. Đối tƣợng và mục đích nghiên cứu 

2.1. Đối tƣợng nghiên cứu 

Nghiên cứu về nhiệt mài khi mài thép ШХ15 bằng đá mài CBN. 

2.2. Mục đích nghiên cứu 

- Cho kết quả đủ độ tin cậy về ảnh hưởng của nhiệt mài tới chất lượng bề mặt chi tiết 

gia công khi mài thép ШХ15 bằng đá mái CBN. 

- Ứng dụng vào trong sản xuất khi mài thép ШХ15 bằng đá mài CBN. 

- Làm cơ sở lý thuyết trong quá trình giảng dạy về công nghệ mài. 

- Làm cơ sở nghiên cứu các vấn đề về nhiệt mài khi mài các vật liệu khác. 

3. Thiết bị thí nghiệm 

Việc nghiên cứu thực nghiệm được tiến hành với các điều kiện sau: 

- Máy thí nghiệm: Máy mài phẳng 3Б725. 

- Vật liệu thí nghiệm: Thép ЩX15, HRC = 58 – 60 và đá mài CBN. 

- Máy vi tính và phần mềm sử lý số liệu. 

4. Phƣơng pháp nghiên cứu 

Dùng phương pháp nghiên cứu lý thuyết kết hợp với nghiên cứu mô phỏng sử dụng 

phương pháp phân tử hữu hạn (FEM) thông qua việc sử dụng phần mềm ANSYS 10.0 

5. Nội dung nghiên cứu 

Phần mở đầu 

Chương 1: Tổng quan về nhiệt cắt và các phương pháp xác định nhiệt cắt khi mài. 

Chương 2: Ứng dụng phần mềm ANSYS để giải bài toán truyền nhiệt.  
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Chương 3: Tính toán và mô phỏng phân bố nhiệt cắt khi mài phẳng. 

Kết luận chung. 

6. Lời cảm ơn 

 Luận văn này đối với tác giả là một cơ hội lớn để rèn luyện khả năng nghiên cứu, thực 

hiện một đề tài khoa học. Trong thời gian thực hiện đề tài, tác giả đã nhận được sự quan tâm rất 

lớn của nhà trường, các khoa, các giảng viên và các đồng nghiệp. 

 Tác giả xin bày tỏ lời cảm ơn chân thành nhất đến T.S. Nguyễn Trọng Hiếu – Giảng 

viên Bộ môn Công nghệ chế tạo máy, Trường Đại học Bách Khoa Hà Nội đã tận tình hướng 

dẫn trong suốt quá trình thực hiện luận văn. 

 Tác giả xin chân thành cảm ơn Ban giám hiệu, Khoa Sau đại học Trường Đại học Kỹ thuật 

Công Nghiệp Thái Nguyên cũng như Ban giám hiệu, đặc biệt là thầy Phó hiệu trưởng- T.S. Ngô 

Cƣờng, Trường Cao Đẳng Kinh Tế - Kỹ Thuật Thái Nguyên đã đóng góp những ý kiến quý báu 

và tạo mọi điều kiện để tác giả hoàn thành luận văn. 

 Tác giả mong sẽ nhận được những ý kiến đóng góp quý báu của các đồng nghiệp, các 

thầy cô giáo để luận văn được hoàn thiện hơn và có ý nghĩa thực tiễn hơn nữa. 

Xin chân thành cảm ơn!  Thái Nguyên, ngày 30 tháng 9 năm 2010 

Người thực hiện 

 

 

Nguyễn Xuân Vinh 

Chƣơng 1 

TỔNG QUAN VỀ NHIỆT CẮT VÀ CÁC PHƢƠNG PHÁP 

XÁC ĐỊNH NHIỆT CẮT KHI MÀI 

1.1. Đặc điểm quá trình mài 

Quá trình mài là quá trình cắt gọt vật liệu bằng các hạt mài có độ cứng cao. Mài có 

nhiều đặc điểm khác biệt so với các phương pháp gia công cắt gọt khác: 
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- Đá mài là loại dụng cụ cắt có rất nhiều lưỡi cắt không liên tục đồng thời tham gia cắt, 

các lưỡi cắt được tạo ra bởi các hạt mài có kích thước rất nhỏ, có hình dáng rất khác nhau và 

phân bố lộn xộn trong chất dính kết. Đa số các hạt mài có nhiều lưỡi cắt, có góc lượn ở đỉnh và 

có góc cắt không thuận lợi cho điều kiện cắt gọt: góc trước  thường âm và góc cắt  thường 

lớn hơn 90
0
. 

- Tốc độ cắt khi mài rất cao (≥ 30 m/s, mài cao tốc có thể lên tới 120 m/s hoặc cao hơn). 

- Do góc cắt không hợp lý, tốc độ cắt cao nên nhiệt độ ở vùng cắt khi mài rất lớn (1000 

÷ 1500
0
 C) làm thay đổi cấu trúc tế vi lớp kim loại bề mặt. 

- Khi mài, mỗi hạt mài tạo ra một phoi riêng biệt có kích thước rất nhỏ, số lượng phoi 

tạo ra trong một đơn vị thời gian rất lớn (hàng nghìn phoi trong một phút), vì thế có thể coi 

quá trình mài là quá trình cào xước tế vi bề mặt gia công tạo ra độ nhẵn bóng và độ chính xác 

cao. 

- Hạt mài có độ cứng cao, cắt gọt không liên tục nên có thể gia công được những vật 

liệu rất cứng mà các dụng cụ khác không cắt được như thép tôi, hợp kim cứng… nhưng lại 

không gia công được những vật liệu rất mềm. 

- Trong quá trình cắt, đá mài có khả năng tự mài sắc: dưới tác dụng của tải trọng cơ, 

nhiệt các hạt mài đã mòn bật ra khỏi bề mặt đá tạo điều kiện cho những hạt mài mới tham gia 

vào quá trình cắt, ngoài ra một số hạt mài vỡ tạo thành những lưỡi cắt mới. 

- Do hiện tượng tự mài sắc cũng như không thể chủ động thay đổi được hình dáng và vị 

trí của hạt mài trong đá mài cho nên việc nghiên cứu và điều khiển quá trình mài gặp nhiều 

khó khăn, các quy luật của quá trình mài chưa được nghiên cứu toàn diện. 

Do những đặc điểm trên, đặc biệt là khả năng gia công các vật liệu có độ cứng và độ 

bền cao cho độ chính xác và độ nhẵn bóng bề mặt cao nên phương pháp mài có vị trí quan 

trọng trong gia công cơ khí hiện đại. Mặc dù được sử dụng cả trong gia công thô nhưng chỉ 

trong gia công tinh thì những ưu thế của phương pháp mài mới thực sự được phát huy, vì vậy 

mài thường được chọn là nguyên công gia công tinh lần cuối các bề mặt quan trọng [2]. 

1.2. Ảnh hƣởng của nhiệt cắt đến chất lƣợng bề mặt chi tiết gia công 
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Trong gia công tinh lần cuối nói chung và gia công tinh lần cuối bằng phương pháp mài 

nói riêng thì chất lượng bề mặt gia công rất được quan tâm vì có ảnh hưởng lớn đến khả năng 

làm việc sau này của chi tiết máy. Chất lượng bề mặt gia công là kết quả của quá trình tương tác 

lý, hóa phức tạp giữa các vật liệu trong vùng gia công. 

1.2.1. Nhiệt cắt trong quá trình mài 

Do tốc độ cắt cao và góc cắt của các hạt mài không thuận lợi cho điều kiện cắt gọt nên 

nhiệt độ ở vùng tiếp xúc giữa đá mài với chi tiết gia công rất lớn (khoảng 1000 1500
0
C), thời 

gian tác dụng để phát sinh nhiệt rất ngắn (1.10
-4

   5.10
-6

s) sau đó nhiệt lại giảm xuống nhanh 

chóng. 

Bảng 1.1. Hệ số truyền nhiệt của thép phụ thuộc vào hàm lượng hợp kim [5]. 

Hàm lượng hợp kim  

2 % Cr 

12 % Cr 

18 % w 

2 % Mn 

1,1 % C 

0,025 

0,050 

0,070 

0,078 

0,102 

Tỷ lệ các nguyên tố hợp kim trong vật liệu là yếu tố ảnh hưởng quyết định đến hệ số 

truyền nhiệt của vật liệu. Những vật liệu có số lượng và hàm lượng nguyên tố hợp kim cao 

thì hệ số truyền nhiệt thấp. Khi mài những loại vật liệu này nhiệt lan truyền chậm làm cho 

nhiệt độ vùng mài tăng cao, bề mặt chi tiết mài dễ bị cháy, nứt (bảng 1.1).  

Khác với các phương pháp cắt gọt khác, nhiệt độ mài chủ yếu truyền vào chi tiết gia công 

(65%84%), phần còn lại truyền vào đá mài (11%12%), vào dung dịch trơn nguội (4% 13%) 

và vào phoi không đáng kể (3%  7%) [2]. 

1.2.2. Ảnh hƣởng của nhiệt cắt đến cấu trúc lớp kim loại bề mặt chi tiết gia công 

Lực cắt khi mài không lớn so với các phương pháp cắt gọt khác nhưng do tốc độ cắt 

cao, góc cắt của các hạt mài không thuận lợi cho điều kiện cắt gọt, sự tham gia cắt gọt của 

nhiều hạt mài và sự ma sát, cào miết của các hạt mài không cắt gọt làm cho nhiệt phát sinh 

trong vùng tiếp xúc giữa đá mài và chi tiết gia công rất lớn (1000 ÷ 1500
o
C). Nhiệt cắt khi mài 
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lớn làm biến dạng mạng tinh thể của vật liệu. Kiểm tra kim tương bề mặt mài của các loại thép 

đã tôi cho thấy có sự thay đổi cấu trúc, lượng ôstenit dư tăng lên chứng tỏ trong quá trình mài 

có sự tôi lại lần hai. Sự thay đổi cấu trúc lớp bề mặt chỉ xảy ra với các loại thép đã tôi cứng còn 

với những loại thép chưa tôi, cấu trúc lớp bề mặt không thay đổi. Kiểm tra kim tương bề mặt mài 

thép đã tôi cho thấy: 

- Lớp 1 được nung tới nhiệt độ 

tới hạn AC3 và được làm nguội nhanh, 

do đó lớp 1 bị tôi lại. 

- Lớp 2 được nung nóng ở nhiệt 

độ AC1 đến AC2 và được làm nguội 

nhanh, do đó lớp 2 được tôi lại không 

đầy đủ. 

- Lớp 3 được nung nóng đến AC1 nên lớp 3 được ram lại. 

- Lớp 4 bị nung nóng nên thể tích tăng không đầy đủ (vì liên kết với lớp 5). 

Kết quả:  

+ Độ cứng lớp bề mặt giảm. 

+ Lớp 1, 2, 3 không có ứng suất dư, lớp 4 có ứng suất dư nén, lớp 5 có ứng suất dư kéo. 

Khi mài thép đã tôi sẽ xảy ra cháy bề mặt mài nếu nhiệt độ mài vượt quá AC3 và sau đó 

được làm nguội nhanh. Chiều sâu lớp bị cháy có thể tới 0,2mm, độ cứng giảm nhiều và thường 

phát sinh vết nứt như trong hình 1.2. 

 

1 3 4 52

Hình 1.1. Cấu trúc lớp bề mặt mài [2]. 
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Hình 1.2. Cấu trúc tế vi pha Austennit của thép không gỉ AISI 304 [14] 

Trong trường hợp mài với chế độ cắt lớn, đá bị cùn thì cháy sẽ xuất hiện ở bề mặt mài 

làm giảm độ cứng lớp kim loại bề mặt (từ 60 ÷ 65 HRC xuống 45 ÷ 55 HRC) đồng thời xuất 

hiện vết nứt trên bề mặt mài [2]. Công suất mài tại ngưỡng cháy bề mặt có thể xác định theo 

công thức thực nghiệm [1]: 

Nch = u0apυfa + bapDe
1/4

a
1/4

υc
1/2

 (1.2) 

Trong đó: 

u0, b - Các hệ số thực nghiệm; 

ap - Bề rộng mài (mm); 

De - Đường kính tương đương của đá mài (mm); 

υf - Vận tốc chi tiết (mm/min) và a -  Chiều sâu mài (mm); 

Cháy bề mặt mài làm giảm tuổi thọ của chi tiết gia công. Vì có ảnh hưởng lớn đến chất 

lượng bề mặt gia công nên các biện pháp giảm nhiệt cắt khi mài được đặc biệt quan tâm. Có 

thể giảm năng lượng mài bằng công nghệ trơn nguội hợp lý hơn, chọn đá mềm hơn, sửa đá thô 

hơn để thỏa mãn điều kiện N  Nch. 

1.2.3. Ảnh hƣởng của nhiệt cắt đến ứng suất dƣ lớp bề mặt chi tiết gia công 

Quá trình chuyển biến về cấu trúc của lớp kim loại bề mặt mài do nhiệt cắt cũng đồng 

thời làm xuất hiện ứng suất dư ở lớp kim loại bề mặt. Ứng suất dư hình thành trong quá trình 

mài do 3 tác động sau: 

- Sự co, giãn vì nhiệt. 

- Sự biến đổi pha do nhiệt độ mài cao. 

- Biến dạng dẻo gây ra do sự tác động qua lại của đá mài và phôi. 

 

 

 

 

 

N
h

iệ
t 

đ
ộ

 

Ứng suất kéo 

Ứng suất nén Ứng suất chảy trên 

Hạt mài 

Ứng suất dư 
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Các yếu tố ảnh hưởng tới ứng suất dư trong lớp bề mặt mài gồm: 

- Điều kiện cắt (chiều sâu cắt, vận tốc đá, vận tốc chi tiết gia công). 

- Topography của đá mài (chế độ sửa đá, trạng thái mòn). 

- Đặc điểm của đá mài (loại và kích thước hạt mài, cấu trúc đá, độ cứng đá và loại chất 

dính kết). 

- Chế độ bôi trơn. 

Sự khác nhau về đặc điểm và topography của đá ảnh hưởng đáng kể đến sự sinh nhiệt 

dẫn đến sự khác nhau về ứng suất dư. Vì tính chất nhiệt và tính chất cơ học của CBN tốt hơn 

của Al203, sự phân chia năng lượng nhiệt vào chi tiết gia công khi sử dụng đá CBN thấp nên 

hư hại do nhiệt giảm, cháy rất ít xuất hiện và ứng suất dư sinh ra chủ yếu là ứng suất dư nén. 

Sự tồn tại ứng suất dư bên trong chi tiết ảnh hưởng lớn đến chất lượng làm việc của chi 

tiết. Nếu trên bề mặt vật mài có lớp ứng suất dư nén thì chất lượng bề mặt chi tiết tốt, tăng độ 

bền mỏi của chi tiết. Ngược lại, nếu trên bề mặt chi tiết gia công có nhiều lớp ứng suất dư kéo, 

chất lượng bề mặt chi tiết gia công giảm, dễ gây ra nứt và chi tiết có thể bị phá hủy đột ngột 

[3]. 

1.2.4. Ảnh hƣởng của nhiệt cắt đến độ nhám bề mặt chi tiết gia công 

Độ nhám bề mặt mài hình thành chủ yếu bởi các vết cào xước chồng lên nhau của các 

điểm cắt có chiều cao không bằng nhau (hình 1.4). 
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Hình 1.4. Sự hình thành độ nhám bề mặt mài [5]. 

Khi mài bằng đá mài thường thì độ nhám trung bình của bề mặt mài    Ra = (0,15 ÷ 

2,5) m. Với đá mài CBN, sau khi chuẩn bị đá ban đầu (điều chỉnh và sửa đá), độ nhám bề 

mặt mài ban đầu có thể đạt mức tương đương với đá mài thông thường sửa đá lần cuối [5]. 

Bằng cách chụp ảnh tế vi bề mặt mài, các nghiên cứu cho thấy độ nhám lý thuyết của 

bề mặt mài tăng lên do các hiện tượng sau [2]: 

- Vật liệu bị nén giãn sang hai bên đường cắt.  

- Kim loại dính vào các hạt mài rồi lại dính trở lại bề mặt phôi. 

- Các hạt mài bị vỡ làm cho quá trình cắt dừng đột ngột tạo ra vết lồi lõm trên bề mặt 

mài đồng thời tạo ra ứng suất tập trung. 

- Các vết nứt trên bề mặt mài do nhiệt mài. 

 

 

         Hình 1.5. Ảnh bề mặt mài dưới kính hiển vi điện tử [3]. 
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 Nhiệt độ ở vùng mài càng cao thì vật liệu gia công ở lớp bề mặt càng biến dạng dẻo 

mạnh đồng thời còn có thể gây cháy, nứt bề mặt: công nghệ tưới nguội, hệ số truyền nhiệt của 

vật liệu gia công và của đá mài ảnh hưởng tới nhiệt độ ở vùng mài qua đó ảnh hưởng tới độ 

nhám bề mặt mài. 

1.3. Ảnh hƣởng của nhiệt cắt đến mòn và tuổi bền của đá mài. 

Tải trọng cơ, nhiệt tác động lên hạt mài là những yếu tố ảnh hưởng nhiều đến mòn và 

tuổi bền của đá. Tăng Sd,υc, a làm tăng lực cắt, nhiệt cắt do đó đá mòn nhanh cả ở dạng cơ học 

và hoá học. Tăng υc thì lực cắt giảm, nhiệt độ mài tăng. Thực nghiệm cho thấy: tăng υc thì mới 

đầu tuổi bền tăng sau đó lại giảm (tuỳ theo ảnh hưởng trội của yếu tố lực cắt hay nhiệt độ mài) 

[2]). 

Đã có nhiều công thức thực nghiệm được xây dựng để xác định tuổi bền của đá mài. Sự khác 

nhau nhiều giữa các công thức thực nghiệm cho thấy rằng không thể xây dựng được một công thức 

tổng quát để tính tuổi bền của đá mài. Tuy nhiên, nhiệt độ mài tăng lên cùng với độ mòn của đá. 

 

1.4. Ảnh hƣởng của nhiệt cắt đến độ chính xác chi tiết gia công. 

Dung sai kích thước và hình dáng hình học chịu ảnh hưởng của biến dạng hệ thống 

công nghệ, biến dạng nhiệt của máy và chi tiết gia công, mòn đá và rung động. Để thoả mãn 

ràng buộc về độ chính xác gia công thường đòi hỏi phải giảm tốc độ bóc vật liệu, do vậy giảm 

được nhiệt cắt trong vùng gia công. Đối với các chi tiết dạng đĩa thì ảnh hưởng của nhiệt khi 

mài càng lớn. 

1.5. Các phƣơng pháp xác định nhiệt cắt trong quá trình mài 

Nhiệt độ là một tham số vật lý quan trọng trong kỹ thuật nói chung cũng như trong quá 

trình mài nói riêng. Trong gia công cơ khí, nó là tham số ảnh hưởng nhiều đến chất lượng chi 

tiết gia công cũng như chịu tác động của nhiều yếu tố khác. Hiện nay, yêu cầu đo chính xác 

nhiệt độ có ý nghĩa quan trọng trong sản xuất cũng như trong các nghiên cứu khoa học, đặc 

biệt trong quá trình mài. 

1.5.1. Phƣơng pháp xác định nhiệt cắt bằng công thức thực nghiệm 

Nhiệt độ mài Tm có thể xác định theo công thức sau [5]:  
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           (1.1) 

Trong đó: 

k - Hệ số thực nghiệm. 

  - Hệ số ma sát giữa đá và vật liệu gia công. 

p - Áp lực riêng ở vùng tiếp xúc (kg/m
2
). 

le - Chiều dài tiếp xúc (mm). 

c - Vận tốc của đá mài (m/s). 

 - Hệ số truyền nhiệt của vật liệu gia công (Kcal/cm.g. độ). 

ρ - Khối lượng riêng của vật liệu gia công (kg/m
3
) 

c - Nhiệt dung của vật liệu gia công (J/kg.độ). 

Công thức (1.1) cho thấy nhiệt độ mài phụ thuộc vào nhiều yếu tố như: chế độ cắt, vật 

liệu gia công, vật liệu hạt mài, chất dính kết, độ xốp của đá mài, dung dịch trơn nguội và 

phương pháp tưới nguội. 

1.5.2. Phƣơng pháp xác định nhiệt cắt bằng thực nghiệm 

Nhiệt độ không thể đo trực tiếp mà phải đo gián tiếp thông qua sự thay đổi tính chất của 

vật liệu theo nhiệt độ. Bởi vậy để đo nhiệt độ cần phải biết được quan hệ phụ thuộc của tính 

chất vật lý của vật đo, của môi trường đo vào nhiệt độ, những tính chất này phải phụ thuộc đơn 

trị vào nhiệt độ. Dưới tác động của nhiệt độ, tính chất của môi trường đo và vật đo thay đổi, 

thông qua xác định tính chất của môi trường đo và vật đo ta xác định được nhiệt độ của môi 

trường đo.  

Theo nguyên tắc đo, chia ra 2 phương pháp đo: Đo không tiếp xúc và đo tiếp xúc. 

1.5.2.1. Phƣơng pháp đo không tiếp xúc 

1. Các kỹ thuật quang học 

Phương pháp này cung cấp hình ảnh đồ họa trường nhiệt của toàn bộ vùng gia công. Nó 

sử dụng một camera bức xạ hồng ngoại để chụp lại những bức xạ nhiệt của vùng gia công 

(hình 1.6). Hình ảnh của trường nhiệt được đem so sánh với vùng nhiệt được mô phỏng bằng 

phương pháp phần tử hữu hạn 2D (FEM) [8]. 



 - 14 - 

 

 

 

 

 

 

 

 

 

 
 

 

 

Ưu điểm:  

Nhiệt độ vùng gia công được đo trong thời gian thực, đọc trực tiếp trong suốt quá trình 

mài. 

Nhược điểm: 

- Camera ghi lại hình ảnh nhiệt từ phía vuông góc với vùng tiếp xúc nên không xác định 

được nhiệt tại vùng cắt. 

- Sự có mặt của dung dịch trơn nguội làm ảnh hưởng đến bức xạ nhiệt trong vùng gia 

công, làm giảm sự đối lưu nhiệt giữa phôi và đá mài. 

- Các tín hiệu nhiệt phải được khuếch đại để so sánh với vùng nhiệt mô phỏng bằng 

phương pháp phần tử hữu hạn nên không đạt được độ chính xác. 

Vì vậy mà phương pháp này chỉ được sử dụng trong điều kiện mài khô. 

2. Kỹ thuật sợi quang học 

Những nghiên cứu về cảm biến sợi quang học đã có thể giúp phát triển một kỹ thuật đo 

nhiệt dựa trên kỹ thuật sợi Bragg. Kỹ thuật này dựa vào sự biến thiên của bước sóng ánh sáng 

phản chiếu. Nó sử dụng kênh phân bước sóng (WDM), bộ ghép nối và phương pháp ghi bước 

sóng mật độ cao (DWDM) để phát hiện sự thay đổi trong các bước sóng. Các cảm biến được 

đặt dưới các bề mặt mài. Do vậy, giá trị đo nhiệt cũng là suy luận và không phải là nhiệt độ tại 

vùng tiếp xúc [8]. 

Đá mài 

Mầu của bề mặt phôi  

Camera hồng ngoại 

Cửa sổ đo  Phôi 

Hình 1.6. Mô hình kỹ thuật đo nhiệt quang học [8]. 
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Kỹ thuật này đắt tiền, dễ hư hỏng khi lắp ráp và sử dụng nên ít được sử dụng. 

1.5.2.2. Phƣơng pháp đo tiếp xúc 

1. Kỹ thuật phủ 

Kỹ thuật này cho phép cung cấp nhiệt độ tối đa khi đo trực tiếp ở một vị trí cụ thể ở 

vùng tiếp xúc giữa phôi và đá mài. Các cảm biến cho nhiệt độ chính xác tại những vị trí của 

vùng tiếp xúc mà ta quan tâm. Các vật liệu có điểm nóng chảy thấp như Indium, Bismuth và 

lớp sơn cảm biến nhiệt đã được sử dụng để ước tính nhiệt độ trong quá trình mài. Phân tích 

kim tương lớp bề mặt cho ta những hiểu biết về những tác động nhiệt đối với tổn hại lớp bề 

mặt tiếp xúc.  

Kato et al khi sử dụng kỹ thuật này để nghiên cứu những ảnh hưởng của nhiệt trong các 

chế độ bóc vật liệu khác nhau đã đi đến kết luận [8]: 

 

- Có thể dùng phương pháp này để đánh giá những tổn hại nhiệt trong lớp bề mặt ở 

chiều sâu cắt khác nhau. 

- Nhiệt độ ước tính hiển thị tốt, do vậy nó cho kết quả đo tin cậy tại những điểm mà ta 

quan tâm. 

Kỹ thuật phủ điểm nóng chảy thấp (PVD) cho ta những hữu ích để so sánh với các 

phương pháp đo nhiệt khác trong quá trình mài. 

Hình 1.7. Cấu trúc tế vi sau một quá trình mài với chế độ bóc vật liệu. 

(a) Q’w = 5 mm
3
/ mms; (b) Q’w = 500 mm

3
/ mms; [8] 
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2. Kỹ thuật cặp nhiệt điện 

a. Hiệu ứng nhiệt điện 

Phương pháp đo nhiệt độ bằng cặp nhiệt ngẫu dựa trên cơ sở hiệu ứng nhiệt điện. 

Người ta nhận thấy rằng khi hai dây 

dẫn chế tạo từ hai vật liệu có bản chất khác 

nhau được nối với nhau bằng mối hàn thành 

một mạch kín và nhiệt độ hai mối hàn là t và t0 

khác nhau thì trong mạch xuất hiện một dòng 

điện. Sức điện động xuất hiện do hiệu ứng 

nhiệt điện gọi là sức điện động nhiệt điện. 

Nếu một đầu của cặp nhiệt ngẫu hàn nối với 

nhau, còn đầu thứ hai để hở thì giữa hai cực xuất hiện một hiệu điện thế. 

Hiện tượng trên có thể giải thích như sau: Trong kim loại luôn luôn tồn tại một nồng độ 

điện tử tự do nhất định phụ thuộc bản chất kim loại và nhiệt độ. Thông thường khi nhiệt độ 

này tăng thì nồng độ điện tử tăng. 

Giả sử ở nhiệt độ t0 nồng độ điện tử trong A là NA(t0), trong B là NB(t0) và ở nhiệt độ t 

nồng độ điện tử trong A là NA(t), trong B là NB(t), nếu NA(t0) > NB(t0) thì nói chung NA(t) > 

NB(t). 

Xét đầu làm việc (nhiệt độ t), do NA(t) > NB(t) nên có sự khuếch tán điện tử từ A sang 

B và ở chỗ tiếp xúc xuất hiện một hiệu điện thế eAB (t) có tác dụng cản trở sự khuếch tán. Khi 

đạt cân bằng eAB (t) sẽ không đổi. 

Tương tự, tại mặt tiếp xúc ở đầu tự do (nhiệt độ t0) cũng xuất hiện một hiệu điện thế eAB 

(t0). 

Giữa hai đầu của một dây dẫn cũng có chênh lệch nồng độ điện tử tự do, do đó cũng có 

sự khuếch tán điện tử và hình thành một hiệu điện thế tương tự trong A là eA (t,t0) và trong B là 

eB (t,t0). 

Sức điện động tổng sinh ra do hiệu ứng nhiệt điện xác định bởi công thức sau: 

EAB = e AB (t) +  e BA (t0) + eA (t0,t) + eB (t,t0) 

Hình 1.8. Sơ đồ nguyên lý cặp nhiệt ngẫu 

[7] 
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Vì eA (t0,t) và  eB (t,t0) nhỏ và ngược chiều nhau có thể bỏ qua, nên ta có: 

EAB = e AB (t) +  e BA (t0) 

Nếu nhiệt độ hai mối hàn bằng nhau, chẳng hạn bằng t0 khi đó sức điện động tổng:   

EAB = e AB (t) +  e BA (t0) = 0 

Hay e AB (t) = - e BA (t0) 

Như vậy EAB = e AB (t) +  e AB (t0) (1.22) 

Phương trình (1.22) này gọi là phương trình cơ bản của cặp nhiệt ngẫu. 

Từ phương trình (1.22) nhận thấy nếu giữ nhiệt độ t0 = const thì: 

EAB = e AB (t) +  C  = f(t)                        (1.23) 

Chọn nhiệt độ ở mối hàn t0 = const biết trước làm nhiệt độ so sánh và đo sức điện động 

sinh ra trong mạch ta có thể xác 

định được nhiệt độ t ở mối hàn 

thứ hai. Sức điện động của cặp 

nhiệt không thay đổi nếu chúng 

ta nối thêm vào mạch một dây 

dẫn thứ ba (hình 1.9) nếu nhiệt 

độ hai đầu nối của dây thứ ba 

giống nhau. 

- Trong trường hợp a:  

EABC (t, t0) = e AB (t) +  e BC (t0)  + e CA (t0)   

Vì:  e AB ( t0) +  e BC (t0)  + e CA (t0)  = 0 nên:  EABC (t, t0) = e AB (t)  -  e CA (t0)   

- Trường hợp b: 

 EABC (t, t1, t0) = e AB (t)  -  e AB (t0)  + e BC (t1)  + e CB  (t1)   

Vì: e BC (t1) = - e CB  (t1)  nên  EABC (t, t0) = e AB (t)  -  e AB (t0)   

            Nếu nhiệt độ hai đầu nối khác nhau sẽ làm xuất hiện sức điện động ký sinh. 

b. Cặp nhiệt hai cực 

Cặp nhiệt hai cực chèn vào phía bên dưới bề mặt phôi cung cấp một tín hiệu đo tốt. Tuy 

nhiên, cặp nhiệt được đặt dưới bề mặt phôi nên nhiệt độ đo được thông qua vật liệu phôi và 

Hình 1.9. Sơ đồ nối cặp nhiệt với dây dẫn thứ ba [7] 

 



 - 18 - 

 

 

 

thông qua cách nhiệt của cặp nhiệt. Các tính chất nhiệt của các mối nối thường bị bỏ qua và đó 

là yếu tố làm cho kết quả đo giảm tính chính xác. Cấu hình thiết lập của cặp nhiệt và phôi 

được chỉ ra trong hình 1.10. 

 

 

 

 

 

N

hiệt độ 

đo được 

là một 

giá trị 

trung 

bình của 

các điểm 

nối của 

cặp nhiệt dưới bề mặt phôi. Trong quá trình lắp ráp cặp nhiệt đòi hỏi các yêu cầu kỹ thuật cao 

về vị trí của các mối nối. 

c. Cặp nhiệt đơn cực 

Cặp nhiệt đơn cực có nguyên lý hoạt động tương tự như cặp nhiệt hai cực. Trong kỹ 

thuật này, các mối nối đầu đo được hình thành với phôi trong khi mài bởi sự bám dính của vật 

liệu cặp nhiệt trên phôi. Do vậy, nó đo được nhiệt độ ngay trên bề mặt tiếp xúc trong vùng cắt. 

Cặp nhiệt đơn cực có thể chèn trong đá mài hoặc vào phôi, nhưng thường được chèn vào phôi 

phân chia. Trong điều kiện mài khô thì kỹ thuật cặp nhiệt đơn cực cho kết quả chính xác hơn 

trong điều kiện mài ướt. 

 

 

Hình 1.10. Cầu hình thiết lập cặp nhiệt hai cực [8]  
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Trong kỹ 

thuật cặp nhiệt, kích 

thước mối nối các cực 

của cặp nhiệt đóng 

vai trò quan trọng trong 

việc xác định chất 

lượng của tín hiệu đo nhiệt. 

1.6. Kết luận chƣơng 1 

1. Phương pháp mài có một vị trí quan trọng trong ngành cơ khí chính xác do khả năng 

gia công những vật liệu có độ cứng, độ bền cao, cho độ chính xác và độ bóng bề mặt cao. 

2. Nhiệt cắt có ảnh hưởng lớn đến chất lượng bề mặt chi tiết gia công trong gia công cơ 

nói chung và đối với phương pháp mài nói riêng. Nó gây ra những tổn hại trên bề mặt chi tiết 

gia công như: hình thành ứng suất dư, làm giảm độ cứng và gây cháy, nứt trên bề mặt chi tiết 

gia công như trong hình 1.12. 

Hình 1.11. Sơ đồ ba cặp nhiệt đơn cực trong phôi [8]. 
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Hình 1.12. Ảnh cấu trúc tế vi cháy bề mặt mài do nhiệt(Qw=1000mm
3
/mm.s)[8]. 

 Mài thường được chọn là nguyên công gia công tinh lần cuối vì vậy chất lượng bề mặt 

mài có ảnh hưởng quan trọng đến khả năng làm việc sau này của chi tiết máy. Các nghiên cứu 

về nhiệt cắt đối với phương pháp mài có tính cấp thiết cao. 

3. Nghiên cứu ảnh hưởng của nhiệt cắt đến chất lượng bề mặt chi tiết gia công và các 

phương pháp xác định nhiệt tại bề mặt tiếp xúc mài là cơ sở để tìm ra các phương pháp xác 

định nhiệt tại vùng tiếp xúc trong quá trình mài nhằm hạn chế những ảnh hưởng của nhiệt tới 

chất lượng chi tiết gia công như tong sơ đồ hình 1.13. Đồng thời tìm ra phương pháp xác định 

nhiệt đủ độ tin cậy trong quá trình gia công. 
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Hình 1.13. Sơ đồ tổng quát nghiên cứu về nhiệt cắt trong quá trình mài 
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Chƣơng 2 

ỨNG DỤNG PHẦN MỀM ANSYS ĐỂ GIẢI BÀI TOÁN TRUYỀN NHIỆT 

2.1. Giới thiệu chung phần mềm ANSYS 

2.1.1 Giới thiệu chung 

Giải bài toán cơ học là một việc vô cùng cần thiết nhưng rất khó khăn. Nhiều bài toán 

lớn, giải với mô hình đồ sộ, cần sử dụng rất nhiều biến và các điều kiện biên phức tạp, với 

không gian nhiều chiều, việc giải bằng tay là một việc không thể thực hiện được. 

Những năm gần đây, nhờ sự phát triển của các công cụ toán cùng với sự phát triển của 

máy tính điện tử, để thiết lập và dần dần hoàn thiện các phần mềm công nghiệp. ANSYS là 

một phần mềm mạnh được phát triển và ứng dụng rộng rãi trên thế giới, có thể đáp ứng các 

yêu cầu nói trên của cơ học. 

Trong tính toán thiết kế cơ khí, phần mềm ANSYS có thể liên kết với các phần mềm 

thiết kế mô hình hình học 2D và 3D để phân tích trường ứng suất, biến dạng, trường nhiệt độ, 

có thể xác định được độ mòn, mỏi và phá huỷ của chi tiết. Nhờ việc xác định đó, có thể tìm 

các thông số tối ưu cho công nghệ chế tạo.  

ANSYS là một trong nhiều chương trình phần mềm công nghiệp, sử dụng phương pháp 

Phần tử hữu hạn (FEM) để phân tích các bài toán vật lý - cơ học, chuyển các phương trình vi 

phân, phương trình đạo hàm riêng từ dạng giải tích về dạng số, với việc sử dụng phương pháp 

rời rạc hóa và gần đúng để giải. 

Nhờ ứng dụng phương pháp phần tử hữu hạn, các bài toán kỹ thuật về cơ, nhiệt, sau khi 

mô hình hoá và xây dựng mô hình toán học, cho phép giải chúng với các điều kiện biên cụ thể 

với số bậc tự do lớn. 

Trong bài toán kết cấu (Structural), phần mềm ANSYS dùng để giải các bài toán trường 

ứng suất - biến dạng, trường nhiệt cho các kết cấu. Trước hết, cần chọn được kiểu phần tử, phù 

hợp với bài toán cần giải. Đồng thời việc chọn phần tử, ANSYS yêu cầu chọn dạng bài toán 

riêng cho từng phần tử. Việc tính toán còn phụ thuộc vào vật liệu. Mỗi bài toán cần đưa mô 

hình vật liệu, cần xác lập rõ là vật liệu đàn hồi hay dẻo, là vật liệu tuyến tính hay phi tuyến, 

với mỗi vật liệu, cần nhập đủ các thông số vật lý của vật liệu. ANSYS là phần mềm giải các 
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bài toán bằng phương pháp số, chúng giải trên mô hình hình học thực. Vì vậy, cần đưa vào mô 

hình hình học đúng. ANSYS có khả năng mô phỏng theo mô hình hình học với các điểm, 

đường, diện tích, và mô hình phần tử hữu hạn với các nút và phần tử. Hai dạng mô hình được 

trao đổi và thống nhất với nhau để tính toán. ANSYS là phần mềm giải bài toán bằng phương 

pháp phần tử hữu hạn (PTHH), nên sau khi dựng mô hình hình học, ANSYS cho phép chia 

lưới phần tử do người sử dụng chọn hoặc tự động chia lưới. Số lượng nút và phần tử quyết 

định đến độ chính xác của bài toán, nên cần chia lưới càng nhỏ càng tốt. Để giải một bài toán 

bằng phần mềm ANSYS, cần đưa vào các điều kiện ban đầu và điều kiện biên cho mô hình 

hình học. Các ràng buộc và các ngoại lực hoặc nội lực (lực, chuyển vị, nhiệt độ) được đưa vào 

tại từng nút, từng phần tử trong mô hình hình học. 

Sau khi xác lập các điều kiện bài toán, để giải chúng, ANSYS cho phép chọn các dạng 

bài toán. Khi giải các bài toán phi tuyến, vấn đề đặt ra là sự hội tụ của bài toán. ANSYS cho 

phép xác lập các bước lặp để giải bài toán lặp với độ chính xác cao. Để theo dõi bước tính, 

ANSYS cho biểu đồ quan hệ các bước lặp và độ hội tụ. Việc xuất các dữ liệu được tính toán 

và lưu trữ, ANSYS có hệ hậu xử lý rất mạnh, cho phép xuất dữ liệu dưới dạng đồ thị, ảnh đồ, 

để có thể quan sát trường ứng suất và biến dạng, đồng thời cũng cho phép xuất kết quả dưới 

dạng bảng số. 

Việc ANSYS có hệ hậu xử lý mạnh, đã đem lại một thế mạnh, để các phần mềm khác 

phải sử dụng ANSYS là một phần mềm liên kết xử lý phân tích trường ứng suất - biến dạng và 

các thông số vật lý khác. 

2.1.2. Các đặc điểm của phần mềm ANSYS 

Các thuộc tính trình diễn của ANSYS - ANSYS Features 

Chọn chế độ phân tích 

Chọn chế độ phân tích điển hình là phương pháp giải, độ cứng phần tử (stress 

stiffening), chọn phương pháp lặp trong bài toán phi tuyến Newton-Raphson. 

Kiểu phân tích 

Các  kiểu phân tích được dùng trong  ANSYS: Phân tích tĩnh (static), phân tích dao 

động riêng (modal), dao dộng điều hòa (harmonic), phân tích bài toán quá độ(transient),phân 
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tích phổ (spectrum), phân tích ổn định (eigenvalue buckling), va cấu trúc con (substructuring) 

và bài toán tuyến tính và phi tuyến. 

Phạm vi sử dụng các sản phẩm ANSYS 

Phần mềm ANSYS có các mô đun sản phẩm riêng biệt sau: 

ANSYS/Multiphysics, 

ANSYS/Mechanical, 

ANSYS/Professional, 

ANSYS/Structural, 

ANSYS/LS-DYNA, 

ANSYS/LinearPlus, 

ANSYS/Thermal, 

ANSYS/Emag, 

ANSYS/FLOTRAN, 

ANSYS/PrepPost, 

ANSYS CFX, 

ANSYS PTD, 

ANSYS TASPCB, 

ANSYS ICEM CFD, 

ANSYS AI*Environment, 

ANSYS DesignXplorer, 

ANSYS DesignModeler, 

ANSYS DesignXplorer VT, 

ANSYS BladeModeler, 

ANSYS TurboGrid, ANSYS AUTODYN 

Sử dụng trợ giúp 

Các thông tin trong phần trợ giúp của ANSYS được viết theo các tiêu đề, dễ tra cứu và 

sử dụng. 
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Toán tử logic Boolean 

Toán tử Boolean Operations (dựa trên cơ sở đại số Boolean) cung cấp công cụ để có thể 

ghép các dữ liệu khi dùng các toán tử logic như: cộng, trừ, chèn, … toán tử Boolean có giá trị 

khi dựng mô hình vật rắn, thể tích, diện tích, đường ( volume, area, and line). 

Trực tiếp tạo phần tử 

Định nghĩa phần tử bằng cách định nghĩa nút. 

Phạm vi ứng dụng khoa học 

Có 5 lĩnh vực khoa học cụ thể giải bằng phần mềm ANSYS: 

Kết cấu – cơ học (Structural), 

Nhiệt (Thermal), 

Điện (Electric), 

Từ (Magnetic), 

Thủy khí (Fluid). 

Nhưng ANSYS còn cho phép giải các bài toán tương tác đa trường vật lý, do các 

trường vật lý thường tác dụng cặp đôi, như nhiệt độ và chuyển vị trong phân tích ứng suất 

nhiệt.  

Chọn phần tử  

Nhiều kiểu phần tử có chọn phần tử được xác định vật thể như vậy là các phần tử với 

các hành vi và chức năng, phần tử cho kết quả được chọn in ra.  

Kiểu phần tử đƣợc dựng 

Cần chỉ rõ phần tử được dùng trong bài toán. Khoảng 200 kiểu phần tử trong ANSYS. 

Ta có thể chọn một kiểu phần tử với các đặc tính, trong đó, xác lập số bậc tự do DOF (như 

chuyển vị, nhiệt độ) cho các hình đặc trưng như đường, hình tứ giác, hình khối hộp, các hình 

nằm trong không gian 2D hoặc 3D, tương ứng với các hệ thống tọa độ. 

Các phần tử bậc cao  

Phần tử với các nút bậc cao có hàm dáng tứ giác và các giá trị bậ tự do.  

Đó là các phần tử gần đúng, dùng tỏng các bài toán với giao diện theo bước. Thời gian 

được lấy thời gian của hệ thống máy tính.  
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Tên bài toán  

Tên File được đặt riêng cho từng bài, nhưng có giá trị trong các phân tích  ANSYS. 

Phần kiểu Jobname.ext, trong đó ext là kiểu File do ANSYS định tùy tính chất của dữ liệu 

được ghi. Tên File được đặt tùy yêu cầu người dùng. Nếu không đặt tên riêng ANSYS mặc 

định là FILE.*. 

Mức độ khó  

Có ba mức độ: dễ, trung bình, khó. Các bài toán khó có thể chuyển thành dễ, khi sử 

dụng bài toán tính theo bước. Tính chất điển hình của advanced ANSYS có dạng như các bài 

toán phi tuyến, macro hoặc advanced post processing. 

Tham chiếu 

Hộp thoại "Preferences" cho phép chọn các lĩnh vực kỹ thuật theo yêu cầu với việc 

chọn lọc thực đơn: Kết cấu, nhiệt, điện từ, thủy khí. Mặc định, thực đơn chọn đưa ra tất cả các 

lĩnh vực, các lĩnh vực không sử dụng được ẩn mờ. Việc chọn được tiến hành bằng cách đánh 

dấu.  

Tiền xử lí  

Là pha phân tích nhập mô hình hình học, vật liệu, kiểu phần tử … 

 Hậu xử lý  

ANSYS phân tích theo pha, ở đó ta có thể xem lại các kết quả phân tích nhờ các hình 

ảnh mầu và các bảng số liệu. Hậu xử lý chung (POST1) được dùng phân tích kết quả tại một 

bước nhỏ trên toàn bộ mô hình vật thể. Hậu xử lý theo thời gian (POST26) được dùng nghiên 

cứu các kết quả tại các điểm đặc biệt trong mô hình trên toàn bộ thời gian các bước.  

Giải  

Là pha phân tích của ANSYS, trong đó xác định kiểu phân tích và chọn, đặt tải và chọn 

tải, khởi động giải phần tử hữu hạn. Mặc định là phân tích tĩnh 

Mô hình hình học 

Trước hết định nghĩa hình dáng hình học cho ANSYS, như định nghĩa một hình chữ 

nhật, có thể định nghĩa theo diện tích, theo 4 cạnh, theo 4 điểm.  

Hằng số thực  
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Cung cấp bổ xung các tham số đặc trưng mặt cắt hình học cho kiểu phần tử, những 

thông tin không thể nhập được vào các nút. Như phần tử vỏ là chiều dày vỏ mỏng, phần tử 

dầm là diện tích của mặt cắt, mô men quán tính của mặt cắt. Các tính chất này được nhập tuỳ 

theo kiểu phần tử yêu cầu.  

Thuộc tính vật liệu  

Thuộc tính vật lý của vật liệu như mô đun đàn hồi, mật độ, luôn độc lập với các tham số 

hình học. Nên chúng không gắn với kiểu phần tử. Thuộc tính vật liệu quy định để giải phần tử 

ma trận phần tử, nên để dễ dàng chúng được gán cho từng kiểu phần tử. Tuỳ thuộc ứng dụng, 

thuộc tính vật liệu có thể là tuyến tính, phi tuyến, hoặc đẳng hướng. Cũng như kiểu phần tử và 

hằng số đặc trưng hình dáng, cần phải đặt thuộc tính vật liệu nhiều lần, tuỳ theo vật liệu. 

Mặt làm việc  

Là một mặt tưởng tượng với gốc toạ độ, dùng để xác lập các tham số hình học cục bộ. 

Trong hệ toạ độ 2D (hệ đề các hay hệ toạ độ cực), mặt làm việc được bám theo từng tham số 

toạ độ. Dùng để định vị một đối tượng của mô hình. Gốc toạ độ của mặt làm việc chuẩn nằm 

trùng với gốc toạ độ toàn cục, gốc tọa độ của các mặt làm việc tự chọn. giữa gốc toạ độ trên 

mặt làm việc chuẩn (toàn thể) có quan hệ với gốc toạ độ cục bộ nằm trên hệ mặt làm việc cục 

bộ.  

2.1.3. Các kiểu phần tử trong Ansys 

Các kiểu phần tử  

STRUCTURE: Phần tử cấu trúc 

SPAR: Phần tử thanh 

BEAM: Phần tử dầm 

PIPE: Phần tử ống 

2D SOLIDS: Phần tử khối đặc 2D 

3D SOLID: Phần tử khối đặc 3D 

SHELL: Phần tử tấm vỏ 

SPECLTY: Phần tử đặc biệt 



 - 28 - 

 

 

 

CONTACT: Phần tử tiếp xúc 

SPAR Phần tử thanh 

2D-SPAR: Phần tử thanh 2D: LINK1 

3D-SPAR: Phần tử thanh 3D: LINK8 

BILINEAR: Phần tử thanh phi tuyến LINK10 

BEAM: Phần tử dầm 

2D-ELAST: Phần tử dầm đàn hồi 2D đối xứng BEAM3 

3D- ELAST: Phần tử dầm đàn hồi 3D, 2~3 nút BEAM4 

2D- TAPER: Phần tử dầm thon 2 nút đàn hồi 2D BEAM54 

3D-TAPER: Phần tử dầm thon 2 nút không đối xứng, 3D BEAM44 

2D-PLAST: Phần tử dầm dẻo 2D2 nút BEAM23 

THIN WALL: Phần tử thanh mỏng 3 nút dầm dẻo BEAM24 

PIPE: Phần tử ống 

STRAIGHT: Phần tử ống thẳng 3D 2 nút đàn hồi PIP16 

TEE: Phần tử ống Tê 3D, 4 nút đàn hồi PIP17 

ELBOW: Phần tử ống cong 3D 3 nút đàn hồi PIP18 

PLASTSTR: Phần tử ống thẳng dẻo 3D, 2 nút PIP20 

PLASTELBOW: Phần tử ống cong dẻo 3D 3 nút PIP60 

IMMORSED: Phần tử ống mềm hoắc cáp PIP59 

2D-SOLID: Phần tử khối đặc 2D 

2D-ELAST: Phần tử khối đặc 2D đàn hồi 

8NodQuad: Phần tử 2D, 8 nút kết cấu tứ diện PLANE82 

4NodQuad: Phần tử 2D, 4 nút kết cấu, tứ diện PLANE42 

Triangle: Phần tử 2D, 6 nút, kết cấu tam giác PLANE2 

HYPER Siêu đàn hồi 

8 NodMixd: Phần tử 2D, 8nút, siêu đàn hồi HYPER74 

4NodMixd: Phần tử 2D, 4 nút, siêu đàn hồi HYPER6 
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8NodQuad: Phần tử 2 D, 8 nút tứ diện, siêu đàn hồi HYPER84 

VISCO Nhớt 

8NodQuad Phần tử 2D, 8 nút tứ diện, nhớt VISCO88 

8NodPlas Phần tử 2D, 8 nút, tứ diện dẻo nhớt VISCO108 

4NodPlas Phần tử 2D, 4 nút, tứ diện dẻo nhớt VISCO106 

HARMONIC Phần tử 2D Điều hoà 

8NodQuad Phần tử 8 nút, đối xứng, điều hoà tứ diện PLANE83 

4NodQuad Phần tử 4 nút, cấu trúc đối xứng trục PLANE25 

3D-SOLID Phần tử vật đặc 3D 

GENERAL Phần tử 3D 

20NodBri: Phần tử khối 3D, 20 nút, hộp, cấu trúc SOLID95 

Brick: Phần tử khối 3D, 8 nút, hộp, cấu trúc SOLID45 

Tetrahod: Phần tử khối 3D, 10 nút, chóp, cấu trúc SOLID92 

RotBrick: Phần tử khối 3D, 8 nút, hộp có DOF quay SOLID92 

RotTetra: Phần tử khối 4 nút, chóp quay SOLID72 

HYPER: Siêu đàn hồi 

Mixbri: Phần tử 3D, 8 nút khối hộp, siêu đàn hồi HYPER58 

Brick: Phần tử 3D, 8 nút, khối hộp, siêu dẻo HYPER86 

VISCO: nhớt 

PlasBrck: Phần tử khối hộp đặc siêu dẻo VISCO107 

ANISOTRP: Khối không đồng nhất 

AnisoBri: Phần tử khối không đồng nhất 3D, 8 nút, hộp SOLID64 

ReinBri: Phần tử khối hộp, bê tông được gia cố SOLID65 

LayerBri: Phần tử khối 3D, 8 nút, hộp, cấu trúc lớp SOLID46 

SHELL: Phần tử dạng tấm- vỏ 

8NodQuad: Phần tử tấm điện- từ, 8 nút, đàn hồi SHELL93 

4NodQuad: Phần tử tấm điện từ, 4 nút, dẻo SHELL63 
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PlastQua: Phần tử tấm điện từ, 4 nút, dẻo SHELL43 

MemBrame: Phần tử mỏng, điện từ, 4 nút SHELL41 

ShearPnl: Phần tử tấm, điện từ, 4 nút, Panel, uốn/xoắn SHELL28 

SPECTLY: Phần tử hỗn hợp 

PINJIONT: Phần tử 3D, 5 nút, liên kết khớp COMBIN7 

ACTUATOR: Phần tử kích động LINK11 

FLUIDCPL: Phần tử cặp đôi, 2 nút, dòng chảy động FUID38 

MATRIX: Phần tử 2 nút, cứng hộp, cản, ma trận MATRIX27 

MASS: Phần tử 1 nút, khối lượng, cấu trúc MASS21 

CONTACT: Phần tử tiếp xúc 

2DPtSurf: Phần tử tiếp xúc điểm - mặt 2D CONTAC48 

3DPtSuf: Phần tử tiếp xúc điểm- mặt 3D CONTAC49 

2DPntPnt: Phần tử tiếp xúc điểm - điểm 2D, ma sát CONTAC12 

3DPntPnt: Phần tử tiếp xúc điểm - điểm 3D CONTAC52 

RigidSur: Phần tử tiếp xúc mặt cứng CONTAC26 

THERMAL Phần tử nhiệt 

LINK Phần tử nhiệt với truyền nhiệt giữa 2 điểm 

2DCnDuct Phần tử thanh dẫn nhiệt 2D LINK32 

3DCnDuct Phần tử thanh dẫn nhiệt 3D LINK33 

CONVert Phần tử 2 nút đối lưu LINK34 

Radiate Phần tử bức xạ nhiệt LINK31 

2D SOLID Phần tử nhiệt đặc 2D 

8Nod Quad Phần tử 2D, 8 nút, tứ giác PLANE77 

4 Nod Quad Phần tử 2D, 4 nút, tứ giác PLANE55 

Triangle Phần tử 2D, 6 nút, tam giác PLANE78 

NodHarm Phần tử 8 nút, đối xứng trục điều hoà PLANE78 

4NodHarm Phần tử 4 nút, đối xứng trục điều hoà PLANE75 
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3D SOLID Phần tử đặc 3 D 

20NodBri Phần tử 3D, 20 nút, hộp đặc SOLID90 

Brick Phần tử 3D, 8 nút, hộp đặc SOLID70 

Tetrahed Phần tử 3D, 10 nút hộp đặc khối chóp SOLID87 

FLUID Phần tử chất lỏng 

2D Quad Phần tử 2D, 4 nút, tứ diện dòng chảy FLUID79 

3D Brick Phần tử 3D, 8 nút khối hộp FLUID80 

HARMONIC Phần tử 4 nút đối xứng, điều hoà, dòng chảy FLUID81 

2D FLOW Phần tử 2D, đẳng tham số, khối đặc, nhiệt- lỏng FLUID15 

PIPE Flow Phần tử 3D, 4 nút, truyền nhiệt - truyền khối FLUID66 

2D Acoust Phần tử 2D, 4 nút, dòng chảy, dưới âm FLUID29 

3D Acoust Phần tử 3D, 8 nút, dòng chảy, dưới âm FLUID30 

MAGNETIC Phần tử từ 

3D SOLID Phần tử 3D cặp đôi điện - từ SOLID96 

8NodQuad Phần tử 2D, 8 nút, cặp đôi điện -từ PLANE53 

2DBound Phần tử 2D, biên vô hạn INFIN9 

3DBound Phần tử 3D, biên vô hạn INFIN47 

SurSourc Phần tử nguồn bề mặt SOURC36 

Other Phần tử phân tích từ, tại các điểm khác nhau 

MULTIFLD Phần tử đa trƣờng 

3D-LINK Phần tử 3D, 2 nút cặp đôi, điện - nhiệt, 1 chiều LINK68 

MultQuad Phần tử 2D đặc, cặp đôi, nhiệt- điện PLAN13 

ThElQuad Phần tử 2D, 4 nút, đặc, cặp đôi nhiệt- điện PLAN67 

MultBrck Phần tử 3D, 8 nút, đặc, cặp đôi SOLID5 

ThElBrck Phần tử 3D, 8 nút, đặc, cặp đôi nhiệt- điện SOLID69 

Tetrahed Phần tử 10 nút, chóp, từ- nhiệt- cấu trúc- điện SOLID98 

GENERAL Mô hình phần tử tổ hợp 
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SprngDmp Phần tử 2 nút, lò xo, cản dọc/xoắn COMBIN14 

Combinat Phần tử 3D, 2 nút, khối lượng- cản- GAP COMBIN40 

ForcDefl Phần tử 2 nút, phi tuyến, lực tập trung- uốn- lò xo COMBIN39 

Control Phần tử điều khiển COMBIN37 

2DSurf Phần tử 2D hiệu ứng bề mặt SURF19 

3DSurf Phần tử 3D hiệu ứng bề mặt SURF22 

Substruc Phần tử cấu trúc con và siêu phần tử MATRIX50 

Bảng 2.1. Bảng danh mục các phần tử trong ANSYS 

Danh mục phần tử theo vần   

BEAM3 - 2-D Elastic Beam 

BEAM4 - 3-D Elastic Beam 

BEAM23 - 2-D Plastic Beam 

BEAM24 - 3-D Thin-walled Beam 

BEAM44 - 3-D Elastic Tapered Unsymmetric Beam 

BEAM54 - 2-D Elastic Tapered Unsymmetric Beam 

BEAM161 - Explicit 3-D Beam 

BEAM188 - 3-D Finite Strain Beam 

BEAM189 - 3-D Finite Strain Beam 

CIRCU94 - Piezoelectric Circuit 

CIRCU124 - General Circuit 

CIRCU125 - Common or Zener Diode 

COMBIN7 - Revolute Joint 

COMBIN14 - Spring-Damper 

COMBIN37 - Control 

COMBIN39 - Nonlinear Spring 
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COMBIN40 - Combination 

COMBI165 - Explicit Spring-Damper 

CONTAC12 - 2-D Point-to-Point Contact 

CONTAC26 - 2-D Point-to-Ground Contact 

CONTAC48 - 2-D Point-to-Surface Contact 

CONTAC49 - 3-D Point-to-Surface Contact 

CONTAC52 - 3-D Point-to-Point Contact 

CONTA171 - 2-D 2-Node Surface-to-Surface Contact 

CONTA172 - 2-D 3-Node Surface-to-Surface Contact 

CONTA173 - 3-D 4-Node Surface-to-Surface Contact 

CONTA174 - 3-D 8-Node Surface-to-Surface Contact 

CONTA178 - 3-D Node-to-Node Contact 

FLUID29 - 2-D Acoustic Fluid 

FLUID30 - 3-D Acoustic Fluid 

FLUID38 - Dynamic Fluid Coupling 

FLUID79 - 2-D Contained Fluid 

FLUID80 - 3-D Contained Fluid 

FLUID81 - Axisymmetric-Harmonic Contained Fluid 

FLUID116 - Thermal-Fluid Pipe 

FLUID129 - 2-D Infinite Acoustic 

FLUID130 - 3-D Infinite Acoustic 

FLUID141 - 2-D Fluid-Thermal 

FLUID142 - 3-D Fluid-Thermal 

HF118 - 2-D High-Frequency Quadrilateral Solid 
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HF119 - 3-D Tetrahedral High-Frequency Solid 

HF120 - 3-D Brick/Wedge High-Frequency Solid 

HYPER56 - 2-D 4-Node Mixed U-P Hyperelastic Solid 

HYPER58 - 3-D 8-Node Mixed U-P Hyperelastic Solid 

HYPER74 - 2-D 8-Node Mixed U-P Hyperelastic Solid 

HYPER84 - 2-D Hyperelastic Solid 

HYPER86 - 3-D Hyperelastic Solid 

HYPER158 - 3-D 10-Node Tetrahedral Mixed U-P 

Hyperelastic Solid 

INFIN9 - 2-D Infinite Boundary 

INFIN47 - 3-D Infinite Boundary 

INFIN110 - 2-D Infinite Solid 

INFIN111 - 3-D Infinite Solid 

INTER115 - 3-D Magnetic Interface 

INTER192 - 2-D 4-Node Linear Interface 

INTER193 - 2-D 6-Node Linear Interface 

INTER194 - 3-D 16-Node Quadratic Interface 

INTER195 - 3-D 8-Node Linear Interface 

LINK1 - 2-D Spar (or Truss) 

LINK8 - 3-D Spar (or Truss) 

LINK10 - Tension-only or Compression-only Spar 

LINK11 - Linear Actuator 

LINK31 - Radiation Link 

LINK32 - 2-D Conduction Bar 
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LINK33 - 3-D Conduction Bar 

LINK34 - Convection Link 

LINK68 - Thermal-Electric Line 

LINK160 - Explicit 3-D Spar (or Truss) 

LINK167 - Explicit Tension-Only Spar 

LINK180 - 3-D Finite Strain Spar (or Truss) 

MASS21 - Structural Mass 

MASS71 - Thermal Mass 

MASS166 - Explicit 3-D Structural Mass 

MATRIX27 - Stiffness, Damping, or Mass Matrix 

MATRIX50 - Superelement (or Substructure) 

MESH200 - Meshing Facet 

PIPE16 - Elastic Straight Pipe 

PIPE17 - Elastic Pipe Tee 

PIPE18 - Elastic Curved Pipe (Elbow) 

PIPE20 - Plastic Straight Pipe 

PIPE59 - Immersed Pipe or Cable 

PIPE60 - Plastic Curved Pipe (Elbow) 

PLANE2 - 2-D 6-Node Triangular Structural Solid 

PLANE13 - 2-D Coupled-Field Solid 

PLANE25 - Axisymmetric-Harmonic 4-Node Structural Solid 

PLANE35 - 2-D 6-Node Triangular Thermal Solid 

PLANE42 - 2-D Structural Solid 

PLANE53 - 2-D 8-Node Magnetic Solid 
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PLANE55 - 2-D Thermal Solid 

PLANE67 - 2-D Thermal-Electric Solid 

PLANE75 - Axisymmetric-Harmonic 4-Node Thermal Solid 

PLANE77 - 2-D 8-Node Thermal Solid 

PLANE78 - Axisymmetric-Harmonic 8-Node Thermal Solid 

PLANE82 - 2-D 8-Node Structural Solid 

PLANE83 - Axisymmetric-Harmonic 8-Node Structural Solid 

PLANE121 - 2-D 8-Node Electrostatic Solid 

PLANE145 - 2-D Quadrilateral Structural Solid p-Element 

PLANE146 - 2-D Triangular Structural Solid p-Element 

PLANE162 - Explicit 2-D Structural Solid 

PLANE182 - 2-D 4-Node Structural Solid 

PLANE183 - 2-D 8-Node Structural Solid 

PRETS179 - 2-D/3-D Pre-tension 

SHELL28 - Shear/Twist Panel 

SHELL41 - Membrane Shell 

SHELL43 - 4-Node Plastic Large Strain Shell 

SHELL51 - Axisymmetric Structural Shell 

SHELL57 - Thermal Shell 

SHELL61 - Axisymmetric-Harmonic Structural Shell 

SHELL63 - Elastic Shell 

SHELL91 - Nonlinear Layered Structural Shell 

SHELL93 - 8-Node Structural Shell 

SHELL99 - Linear Layered Structural Shell 
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SHELL143 - 4-Node Plastic Small Strain Shell 

SHELL150 - 8-Node Structural Shell p-Element 

SHELL157 - Thermal-Electric Shell 

SOLID69 - 3-D Thermal-Electric Solid 

SOLID70 - 3-D Thermal Solid 

SOLID87 - 3-D 10-Node Tetrahedral Thermal Solid 

SOLID90 - 3-D 20-Node Thermal Solid 

SOLID95 - 3-D 20-Node Structural Solid 

SOLID96 - 3-D Magnetic Scalar Solid 

SOLID97 - 3-D Magnetic Solid 

SOLID117 - 3-D 20-Node Magnetic Solid 

SOLID185 - 3-D 8-Node Structural Solid 

SOLID186 - 3-D 20-Node Structural Solid 

SURF151 - 2-D Thermal Surface Effect 

SURF152 - 3-D Thermal Surface Effect 

 

2.1.4. Các tham số trong ANSYS 

Bảng 2.2. Bảng các tham số trong ANSYS 

Nhãn  Thứ nguyên Ý nghĩa 

EX 

Lực / Diện tích 

Mô đun đàn hồi theo hướng x của phần tử 

EY Mô đun đàn hồi theo hướng y của phần tử 

EZ Mô đun đàn hồi theo hướng z của phần tử 

GXY 
Lực / Diện tích 

Mô đun trượt trên mặt x-y 

GYZ Mô đun trượt trên mặt y-z 
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GXZ Mô đun trượt trên mặt x-z 

ALPX 
 

Biến dạng / Nhiệt độ 

Hệ số dãn nở nhiệt theo hướng x của phần tử 

ALPY Hệ số dãn nở nhiệt theo hướng y của phần tử 

ALPZ Hệ số dãn nở nhiệt theo hướng z của phần tử 

REFT Nhiệt độ Nhiệt độ tham chiếu làm gốc 

MU Không Hệ số ma sát ( FLUID29 và FLUID30) 

DAMP Thời gian Ma trận hãm 

DENS Khối lượng/Thể tích Mật độ khối  

KXX Nhiệt *Chiều 

dài/T.gian*D.tích* 

Nhiệt độ 

Hệ số dẫn nhiệt theo hướng x của phần tử 

KYY Hệ số dẫn nhiệt theo hướng y của phần tử 

KZZ Hệ số dẫn nhiệt theo hướng z của phần tử 

C 
Nhiệt / Khối lượng * 

Nhiệt độ 
Nhiệt dung 

ENTH Nhiệt / Thể tích Enthalpy 

HF 
Nhiệt/(T.gian*D.tích*

Nhiệt độ) 
Hệ số đối lưu 

EMIS Không  Hệ số thẩm thấu 

QRATE Nhiệt/ t.gian Tốc độ sinh nhiệt (dùng phần tử MASS71) 

VISC 
Lực * Th. Gian/ 

 (chiều dài)
2 

Độ nhớt 

SONIC Chiều dài/ T.gian Tốc độ âm (FLUID29, FLUID30) 

MGXX 
Tải/ 

(Chiều dài*Thời gian) 

Sức từ kháng theo phương x của phần tử 

MGYY Sức từ kháng theo phương y của phần tử 

MGZZ Sức từ kháng theo phương z phần tử 

RSVX 
Điện trở*Diệntích / 

Chiều dài 

Điện trở suất theo phương x 

RSVY Điện trở suất theo phương y 

RSVZ Điện trở suất theo phương z 
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PERX 

Tải 
2
/(Lực*Chiều dài 

2
) 

Hệ số điện mối theo phương x 

PERY Điện trở suất theo phương y 

PERZ Điện trở suất theo phương z 

LSST Không Tang tổn thất cách điện 

 

2.1.5. Các mô hình vật liệu trong ANSYS 

Bảng 2.3. Bảng các mô hình vật liệu trong ANSYS 

Mô hình Liên kết với 
Kiểu liên 

kết 
Lệnh, nhãn 

Kết nối 

 ví dụ 

Plasticity 
Combined 

Hardening 
Bilinear 

TB, BISO + 

TB, CHAB 

BISO và 

CHAB, Ví dụ 

Plasticity 
Combined 

Hardening 
Multilinear 

TB, MISO + 

TB, CHAB 

MISO và 

CHAB, Ví dụ  

Plasticity 
Combined 

Hardening 
Nonlinear 

TB, NLISO+ 

TB, CHAB 

NLISO và 

CHAB Ví dụ 

Viscoplasticity 
Isotropic 

Hardening 
Bilinear 

TB, BISO + 

TB, RATE 

BISO và 

RATE Ví dụ 

Viscoplasticity 
Isotropic 

Hardening 
Multilinear 

TB, MISO + 

TB, RATE 

MISO và 

RATE Ví dụ 

Viscoplasticity 
Isotropic 

Hardening 
Nonlinear 

TB, NLISO+ 

TB, RATE 

NLISO và 

RATE Ví dụ 

Plasticity and 

Creep(Implicit) 

Isotropic 

Hardening 
Bilinear 

TB, BISO + 

TB, CREEP 

BISO và 

CREEP,Ví dụ 

Plasticity and 

Creep(Implicit) 

Isotropic 

Hardening 
Multilinear 

TB, MISO + 

TB, CREEP 

MISO và 

CREEP,Ví dụ 

Plasticity and 

Creep(Implicit) 

Isotropic 

Hardening 
Nonlinear 

TB, NLISO+ 

TB, CREEP 

NLISO và 

CREEP,Ví dụ 

Plasticity and Kinematic Bilinear TB, BKIN + BKIN và 
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Creep(Implicit) Hardening TB, CREEP CREEP,Ví dụ 

Anisotropic 

Plasticity 

Isotropic 

Hardening 
Bilinear 

TB, HILL + 

TB, BISO 

HILL và 

BISO, Ví dụ 

Anisotropic 

Plasticity 

Isotropic 

Hardening 
Multilinear 

TB, HILL + 

TB, MISO 

HILL và 

MISO, Ví dụ 

Anisotropic 

Plasticity 

Isotropic 

Hardening 
Nonlinear 

TB, HILL + 

TB, NLSIO 

HILL và 

NLISO, Ví dụ 

Anisotropic 

Plasticity 

Kinematic 

Hardening 
Bilinear 

TB, HILL + 

TB, BKIN 

HILL và 

BKIN, Ví dụ 

Anisotropic 

Plasticity 

Kinematic 

Hardening 
Chaboche 

TB, HILL + 

TB, CHAB 

HILL và 

CHAB, Ví dụ 

Anisotropic 

Plasticity 

Combined 

Hardening 

Bilinear 

Isotropic and 

Chaboche 

TB, HILL + 

TB, BISO + 

TB, CHAB 

HILL và 

BISO và 

CHAB, Ví dụ 

Anisotropic 

Plasticity 

Combined 

Hardening 

Nonlinear 

Isotropic và 

Chaboche 

TB, HILL + 

TB, NLISO+ 

TB, CHAB 

HILL và 

NLISO và 

CHAB, Ví dụ 

 

 

2.1.6. Các xử lý dùng trong ANSYS. Processors (Routines) 

Bảng 2.4. Bảng các xử lý dùng trong ANSYS 

 

Xử lý Hàm Đƣờng dẫn Lệnh 

PREP7 
Thiết lập mô hình hình học 

và thuộc tính vật liệu 

Main  

Menu> Preprocessor 
/PREP7 

SOLUTION Đặt tải và giải  Main Menu>Solution /SOLU 

POST1 
Xuất kết quả đối với đối 

tượng tại thời điểm khảo sát  

Main Menu>General 

Postproc 
/POST1 
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POST26 

Xuất kết quả tại một thời điểm 

trong mô hình với hàm thời gian  

Main 

Menu>TimeHist 

Postpro 

/POST26 

 

OPT Hoàn thiện bản vẽ ban đầu 
Main Menu> 

Design Opt 
/OPT 

PDS 

Định lượng hiệu quả phân 

tán và ngẫu nhiên với biến 

nhập vào của phần tử đối 

với kết quả phân tích  

Main 

Menu>Prob Design 
/PDS 

AUX2 

Các File nhị phân dạng đọc 

được Dump binary 

Utility Menu>File> 

List>BinaryFiles 

Utility>  

Menu> ist>Files> 

Binary 

/AUX2 

AUX12 
Tính các hệ số bức xạ, tạo ma 

trận bức xạ của bài toán nhiệt  

Main>Menu> 

Radiation>Matrix 
/AUX12 

AUX15 
Chuyển File CAD 

Hoặc chương trình FEA 

Utility>Menu> 

File>Import 
/AUX15 

 

 

2.1.7. Các lệnh khởi động và giao diện màn hình ANSYS 10.0 

2.1.7.1. Lệnh Start >Program > ANSYS 10.0 

Sau khi khởi động Windows, ta có thể khởi động ANSYS như sau: 

Vào các lệnh: Start > Program > Ansys 10 để chọn các chức năng khởi động, để chọn 

các mô đun chức năng. 

Mỗi chức năng có thể khởi động riêng biệt: 

ANS_Admin: dùng nhập các thiết bị quản lý. 

ANSYS System Help: dùng khởi động trợ giúp hệ thống. 
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CMAP Utility: Dùng khởi động chương trình thiết kế bản đồ màu. 

DISPLAY Utility: dung khởi động các chương trình xem ảnh đồ và hình vẽ được 

ANSYS tạo ra kiểu *.GRP và ảnh động *.AVI; 

Help System: khởi động trợ giúp và tra cứu. 

INTERACTIVE: khởi động chương trình ANSYS chính, trong đó hộp thoại điều khiển, 

cần chọn các tham số theo yêu cầu hộp thoại. 

RUN INTERACTIVE NOW: khởi động ANSYS mặc định. 

INTERACTIVE thiết lập môi trường làm việc cho ANSYS, gồm: 

Đường dẫn làm việc và môi trường đồ họa, tên file sẽ dung, đặt dung lượng vùng làm 

việc, đọc file START.ANS, định nghĩa tham số, chọn ngôn ngữ. Sau khi thiết lập, chọn Run. 

Hộp các hướng xuất hiện, đọc làm theo hoặc mặc định. Chọn Ok để khởi động tiếp. 

2.1.7.2. Màn hình giao diện ANSYS 10.0 

 

Hình 2.1: Giao diện màn hình Ansys 10.0 

ANSYS Menu Utility: Thanh Menu tiện ích, chứa các tiện ích bổ sung các lệnh phụ trợ, 

kiểm soát các thiết lập và nhập xuất dữ liệu.  

ANSYS Main Menu: Menu chính, chứa các lệnh chính của ANSYS. 
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ANSYS input: cửa sổ nhập lệnh từ bàn phím. 

ANSYS Graphic: cửa sổ đồ họa. 

ANSYS Toolbar: các thanh chức năng ghi lưu trữ dữ liệu, thoát, chế độ đò họa và các 

thiết lập do người dùng tạo ra.  

ANSYS Output: cửa sổ ghi lại toàn bộ các việc làm của  ANSYS và các kết quả tính 

toán phân tích. 

2.2. Ứng dụng phần mềm ANSYS trong việc giải các bài toán truyền nhiệt 

2.2.1. Bài toán cơ bản về truyền nhiệt trong vật rắn  

Giả sử vật liệu của vật rắn có hệ số truyền nhiệt K =10w/m.C và vật rắn được coi như 

dài vô hạn. Nhiệt độ tại các bề mặt cho như hình 2.2. 

 

 

 

 

 

 

 

 

 

 

 

 

2.2.1.1.Tiền xử lý: Định nghĩa các phần tử 

1. Mô hình hóa hình học 

Preprocessor > Modeling > Create > Areas > Rectangle > By 2 Corners > 

 X= 0, Y = 0, Width = 1, Height = 1, BLC4,0,0,1,1 

2. Khai báo kiểu phần tử 

Hình 2.2. Mô hình vật rắn khi phân tích nhiệt 
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Preprocessor >Element Type >Add/Edit/Delete...> click 'Add' > Select Thermal Mass 

Solid, Quad 4Node 55  

ET,1,PLANE55 

Trong bài toán này, chúng ta sẽ sử dụng PLANE55 (thermal solid, quad4 node55). Phần 

tử này chứa 4 điểm nút và nhiệt độ đơn nhất trên các nút (DOF temperature). PLANE55 chỉ có 

thể sử dụng khi cho bài toán phân tích tĩnh hai chiều (2 dimensional steady - state) hoặc phân 

tích nhiệt Transient. 

3. Khai báo thuộc tính vật liệu 

Preprocessor > Material Props > Material Models > Thermal > conductivity > Isotropic 

> KXX = 10 (Thermal conductivity)  

MP,KXX,1,10  

4. Kích thước lưới 

Preprocessor > Meshing > Size Cntrls >ManualSize > Areas > All Areas > 0.05 

AESIZE,ALL,0.05 

5. Tạo lưới 

Preprocessor > Meshing > Mesh > Areas > Free > Pick All   

AMESH, ALL 

2.2.1.2. Đặt tải và giải bài toán 

1. Khai báo kiểu phân tích 

Solution > Analysis Type > New Analysis > Steady-State 

ANTYPE,0 

2. Đặt tải nhiệt 

Đối với các vấn đề về nhiệt, những khó khăn có thể xuất phát từ dạng nhiệt độ, dòng 

nhiệt, sự đối lưu nhiệt, thông lượng nhiệt, dạng nguồn nhiệt hoặc sự bức xạ. Đối với bài toán 

này, cả 4 mặt của vật rắn đều được đặt nhiệt độ. 

+ Solution > Define Loads > Apply 

+ Thermal > Temperature > On Nodes 
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Lựa chọn Box và chọn tất cả các điểm nút thuộc đường thẳng trên cùng sau đó cửa sổ 

sau sẽ xuất hiện. 

 

 

 

 

 

 

 

 

 

 

 

   Điền vào giá trị nhiệt độ 500
0
C như thực hiện trong cửa sổ, sau đó chọn Apply. 

+ Thực hiện các bước chọn các điểm nút tương tự như mặt trên đối với 3 mặt còn lại. 

Tuy nhiên, giá trị tải nhiệt được chọn là 100 
0
C. 

3. Giải bài toán 

Solution > Solve > Current  

LS SOLVE 

2.2.1.3. Hậu xử lý: Quan sát kết quả  

Plot Temperature  

General Postproc > Plot Results > Contour Plot > Nodal Solu ...> DOF solution, 

Temperature  

TEMP 

Hình 2.3. Cửa sổ lệnh đặt tải nhiệt trên các điểm thuộc mặt trên 
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Hình 2.4. Mô hình nhiệt của vật rắn chịu tải nhiệt có 4 mặt dài vô hạn (K=10 w/m.C) 

2.2.2. Bài toán kết hợp giữa truyền nhiệt và đối lƣu nhiệt (Truyền nhiệt/ đối lƣu nhiệt / 

cách nhiệt)  

Phân tích hiện tượng truyền nhiệt đơn giản cũng như các vấn đề về sự kết hợp của 

truyền nhiệt, đối lưu nhiệt và cách nhiệt sẽ được làm rõ. Bài toán tổng hợp về truyền nhiệt, đối 

lưu nhiệt và cách nhiệt được chỉ ra trong hình vẽ sau:  

 

Hình 2.5. Mô hình của vật rắn khi đặt tải nhiệt kết hợp giữa  

truyền nhiệt và đối lưu nhiệt 
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2.2.2.1. Tiền xử lý: Định nghĩa các phần tử 

1. Mô hình hóa hình học 

Preprocessor > Modeling > Create > Areas > Rectangle > By 2 Corners > X= 0, Y= 0, 

Width = 1, Height = 1 

BLC4,0,0,1,1 

2. Khai báo loại phần tử 

Preprocessor> Element Type> Add/Edit/Delete...> click 'Add' > Select Thermal Mass 

Solid, Quad 4Node 55 

ET,1,PLANE55 

Tương tự như bài toán cơ bản về truyền nhiệt trên, chúng ta cũng sẽ sử dụng PLANE55 

(thermal Solid, Quad 4node 55). Phần tử này có 4 điểm nút và chỉ có một bậc tự do (nhiệt độ) 

trên mỗi nút. PLANE55 chỉ có thể sử dụng đối với hai thông số tĩnh hoặc phân tích nhiệt tĩnh. 

3. Khai báo thuộc tính vật liệu 

Preprocessor> Material Props> Material Models> Thermal> Conductivity > Isotropic > 

KXX = 10 

 MP,KXX,1,10 

Điều này sẽ là đặc biệt với hệ số truyền nhiệt K = 10W/m.C 

4. Kích thước lưới 

Preprocessor> Meshing > Size Cntrls > ManualSize > Areas > All Areas > 0.05 

AESIZE, ALL, 0.05 

5. Chọn dạng chia lưới 

Preprocessor > Meshing > Mesh > Areas > Free > Pick All  

AMESH, ALL 

2.2.2.2. Đặt tải nhiệt và giải bài toán 

1. Khai báo kiểu phân tích 

Solution > Analysis Type > New Analysis > Steady- State 

ANTYPE, 0 
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2. Đặt tải truyền nhiệt 

Trong bài toán này, cả hai mặt của vật rắn đều đặt tải nhiệt, trong khi đó sẽ đặt điều 

kiện đối lưu nhiệt trong hai mặt còn lại. 

* Solution > Define Loads > Apply > Thermal > Temperature > On Lines 

* Chọn đường thẳng trên cùng và đặt giá trị nhiệt bằng 500
0
C. 

* Thực hiện tương tự đối với mặt trái của khối và đặt tải nhiệt bằng 100
0
C. 

3. Đặt điều kiện đối lưu nhiệt 

* Solution > Define Loads > Apply > Thermal > Convection > On Lines 

* Chọn mặt bên phải của vật khối, khi đó thì cửa sổ sau sẽ xuất hiện (hình 2.6) 

* Điền các giá trị vào như trên hình 2.5. Nhiệt độ là 100 
0
C, hệ số đối lưu nhiệt 

10W/m
2
*C. Chú ý rằng VALJ và VAL2J đã được bỏ trống bởi vì hệ số đối lưu nhiệt truyền 

ngang qua các đường thẳng. 

 
 

Hình 2.6. Cửa sổ đặt tải đối lưu nhiệt 10W/m
2
*C 

4. Đặt các điều kiện cách nhiệt 

* Solution > Define Loads > Apply > Thermal > Convection > On Lines 

* Chọn mặt trên của vật khối 

* Nhập một  giá trị VALI là 0. Điều này sẽ khử được sự đối lưu nhiệt xuyên qua các bề 

mặt, khi đó mô hình chung thành một bức tường cản nhiệt.  
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Hình 2.7. Tạo lưới trong bài toán truyền nhiệt và đối lưu nhiệt 

5. Giải bài toán 

Solution > Solve > Current  

LS SOLVE 

2.2.2.3. Hậu xử lý: Quan sát kết quả 

Plot Temperature  

General Postproc > Plot Results > Contour Plot > Nodal Solu ...> DOF solution, 

Temperature  TEMP 

 
 

Hình 2.8. Miền nhiệt của vật rắn có sự truyền nhiệt và đối lưu nhiệt 

2.2.3. Bài toán phân tích truyền nhiệt quá độ  
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Chúng ta hoàn toàn có thể giải quyết các vấn đề phân tích truyền nhiệt quá độ bằng 

phần mềm ANSYS. Mô hình nhiệt được quan sát trong hình 2.9. Hệ số dẫn nhiệt K của vật 

liệu là 5 W/m*K và vật khối là dài vô hạn. Trọng lượng riêng của vật liệu là 920kg/m
3
 và nhiệt 

dung (C) là 2040KJ/kg*K. 

 

Hình 2.9. Mô hình vật rắn chịu tải nhiệt quá độ 

2.2.3.1. Tiền xử lý: Định nghĩa các phần tử 

1. Ghi tên cho bài toán 

Utility Menu > File > Change Title...  

/Title, Transient Thermal Conduction 

2. Mở menu tiền xử lý 

ANSYS Main Menu > Preprocessor 

/PREP7 

3. Mô hình hóa hình học 

Preprocessor > Modeling > Create > Areas > Rectangle > By 2 Corners  

X= 0, Y= 0, Width= 1, Height= 1 

BLC4, 0, 0, 1, 1 

4. Khai báo kiểu phần tử 

Preprocessor > Element Type > Add/Edit/Delete...> click 'Add' > Select Thermal Mass 

Solid, Quad 4Node 55 
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ET,1,PLANE55 

Trong bài toán này, ta sử dụng phần tử PLANE55 (Thermal Solid, Quad 4 node 55). 

Phần tử này có 4 điểm nút và mỗi nút có nhiệt độ riêng biệt. 

5. Đặc tính vật liệu của phần tử 

Preprocessor > Material Props > Material Models > Thermal > Conductivity > Isotropic 

> KXX = 5 (Thermal conductivity) 

MP,KXX,1,10 

Preprocessor> Material Props > Material Models  > Thermal> Specific Heat > C = 2.04 

MP,C,1,2.04 

Preprocessor > Material Props > Material Models > Thermal > Density > DENS = 920 

MP,DENS,1,920 

6. Kích thước lưới 

Preprocessor> Meshing > Size Cntrls > ManualSize > Areas > All Areas > 0.05 

AESIZE,ALL,0.05 

7. Tạo lưới 

Preprocessor > Meshing > Mesh > Areas > Free > Pick All AMESH,ALL 

 
 

Hình 2.10: Tạo lưới cho bài toán truyền nhiệt quá độ 

2.2.3.2. Đặt tải nhiệt và giải bài toán 

1. Khai báo kiểu phân tích 

Solution > Analysis Type > New Analysis > Transient 
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ANTYPE,4 

 

 

Hình 2.11: Phương pháp phân tích bài toán 

2. Thiết lập chế độ điều khiển 

Solution > Analysis Type > Sol'n Controls 

Khi đó xuất hiện cửa sổ thoại sau: 

 
 

Hình 2.12: Chọn chế độ điều khiển phân tích 

Chọn và ghi các thông số như trong hình 2.12 và 2.13. 
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Hình 2.13. Chọn các chế độ phân tích 

Mô tả đầy đủ về các lựa chọn như trong hình 2.11; 2.12; 2.13 có thể tham khảo các tập 

tin trợ giúp. Về cơ bản, thởi gian đặt tải cuối phân tích trong bao lâu phụ thuộc vào các bước 

đặt tải. Bằng cách viết dữ liệu cho từng bước thực hiện, ta có thể chạy mô phỏng động theo 

thời gian và các tùy chọn khác giúp vấn đề hội tụ được nhanh chóng. 

3. Những vấn đề khi đặt tải nhiệt 

Đối với các vấn đề truyền nhiệt, những khó khăn có thể là nhiệt độ, dòng nhiệt, đối lưu 

nhiệt, truyền nhiệt, bản chất nguồn nhiệt hoặc bức xạ. Trong bài toán này, 2 mặt của vật khối 

được đặt tải nhiệt và hai mặt còn lại cách nhiệt. 

* Solution > Define Loads > Apply 

Chú ý rằng các chọn lựa về phân tích cấu trúc không được chọn. Điều này được thực 

hiện khi định nghĩa phần tử chọn cho bài toán là PLANE 55. 

* Thermal > Temperature > On Nodes 

* Chọn Box để chọn các điểm nút của đường thẳng trên cùng của vật khối, sau đó chọn 

OK. 
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Hình 2.14. Đặt tải nhiệt cho các điểm nút trên vật khối 

Sau đó, của sổ thoại sau sẽ xuất hiện 

 

Hình 2.15. Đặt tải nhiệt cho các điểm nút 

* Điền vào cửa sổ giá trị nhiệt cho các điểm nút trên đường thẳng trên cùng của vật 

khối giá trị nhiệt là 500 K. 

* Thực hiện tương tự cho các điểm nút trên đường thẳng dưới cùng của vật khối giá trị 

nhiệt là 100 K 

4. Thiết lập điều kiện ban đầu 

Solution > Define Loads > Apply > Initial Condit'n > Define > Pick All 
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Điền vào trong cửa sổ IC sau các giá trị nhiệt độ ban đầu của vật liệu là 100 K 

 

Hình 2.16. Định nghĩa các điều kiện nhiệt độ ban đầu của vật liệu 

5. Giải bài toán 

Solution > Solve > Current  

LS SOLVE 

2.2.3.3. Hậu xử lý: Quan sát kết quả 

1. Kết quả khi sử dụng ANSYS 

Plot Temperature  

General Postproc > Plot Results > Contour Plot > Nodal Solu ...> DOF solution, 

Temperature TEMP 

 

Hình 2.17. Kết quả mô phỏng bài toán truyền nhiệt quá độ bằng ANSYS 

Kết quả mô phỏng theo thời gian 
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* Trước hết, chọn dạng contour. 

Utility Menu > PlotCtrls > Style > Contours > Uniform Contours... 

Điền vào cửa sổ sau, với 8 contour, thấp nhất là 100 đến 500. 

 

Hình 2.18. Định dạng contour 

* Sau đó, nhập các dữ liệu mô phỏng động 

Utility Menu > PlotCtrls > Animate > Over Time... 

Điền vào cửa sổ sau với các tham biến như trong hình vẽ 2.19. 

 

Hình 2.19.  Thiết lập các tham biến mô phỏng theo thời gian 

Chúng ta có thể quan sát được sự biến thiên nhiệt độ theo thời gian. Các dòng nhiệt ở 

mức cao đến mức thấp đều được mô tả. Tuy nhiên, chúng ta cũng có thể chỉ ra nhiệt độ đạt 
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trạng thái cân bằng trong khoảng 20 giây. Dưới đây là biểu đồ phân tích bằng ANSYS mối 

quan hệ giữa nhiệt độ và thời gian đối với trung tâm của vật khối. Như quan sát thấy, các 

đường cong thực là như nhau, điều này chứng minh được hiệu lực mô phỏng của ANSYS. 

 

Hình 2.20. Biểu đồ quan hệ giữa nhiệt độ và thời gian ở trung tâm vật khối 

2. Quan sát kết quả dưới dạng biểu đồ 

a. Thiết lập biểu đồ quan hệ nhiệt độ và thời gian 

* Chọn Main Menu > TimeHist Postpro. Cửa sổ sau sẽ tự động mở ra. 

 

Hình 2.21. Thiết lập thời gian tại tâm vật khối 

* Chọn nút  ở góc trên của cửa sổ. 

* Chọn Nodal Solution > DOF Solution > Temperature và kích OK. Kích vào giữa của 

vật khối trên lưới đã tạo ra, điểm nút 261 và kích OK.  
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Hình 2.22. Chọn biến thời gian cho điểm nút tâm của vật khối 

Biến thời gian sẽ được hiện ra như trong cửa sổ sau: 

 

Hình 2.23.Thiết lập biến thời gian cho tâm vật khối 

b. Biểu đồ kết quả theo thời gian 

* Tham biến TEM_2 trong cửa sổ Time History Variable hiện sáng. 

* Kích vào biểu tượng graph  trong cửa sổ Time History Variable. 

* Chúng ta có thể thay đổi các trục của biểu đồ theo ý muốn, thực hiện như sau: Utility 

Menu > Plot Ctrls > Style > Graphs > Modify Axes  
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Hình 2.24. Biểu đồ quan hệ giữa nhiệt độ và thời gian ở trung tâm vật khối 

Sự biến thiên trong biểu đồ phải phù hợp với biến thiên nhiệt mà bài toán đặt ra. Một 

vài nguyên nhân làm cho bài toán không hội tụ. Để bài toán được hội tụ có thể thực hiện các 

biện pháp sau: Giảm kích thước các mắt lưới hoặc tăng số lượng các bước phân tích. Kinh 

nghiệm cho thấy, tăng các mắt lưới ít được sử dụng. Do vậy, người ta đã tăng số lượng các 

bước phân tích từ 2 ÷30 bước. Điều này sẽ làm tăng thời gian tính toán. 

2.3. Kết luận chƣơng 2 

1. ANSYS là một trong nhiều chương trình phần mềm công nghiệp, sử dụng phương 

pháp Phần tử hữu hạn để phân tích, giải các bài toán vật lý - cơ học. Nhờ ứng dụng phương 

pháp phần tử hữu hạn, các bài toán kỹ thuật về cơ, nhiệt, thuỷ khí, điện từ, sau khi mô hình 

hoá và xây dựng mô hình toán học, cho phép giải chúng với các điều kiện biên cụ thể với số 

bậc tự do lớn. 

2. Trong các bài toán truyền nhiệt trong cơ khí, phần mềm ANSYS đã giải quyết triệt 

để các vấn đề mà bài toán đặt ra. Do vậy, có thể ứng dụng phần mềm này để nghiên cứu về 

nhiệt cắt trong quá trình mài. 

3. Hiện nay, các nghiên cứu về nhiệt trong quá trình mài bằng đá mài CBN chưa nhiều, 

tại Việt Nam thì chưa có công trình nào được công bố. Để sử dụng đá mài CBN một cách hiệu 

quả cần có nhiều nghiên cứu hơn nữa về vấn đề này.  
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Chƣơng 3 

TÍNH TOÁN VÀ MÔ PHỎNG PHÂN BỐ NHIỆT CẮT KHI MÀI PHẲNG 

3.1. Xây dựng mô hình tính nhiệt khi mài phẳng 

3.1.1. Động học quá trình mài 

Để dự đoán chính xác nhiệt độ mài bằng cách sử dụng các mô hình nhiệt động phải 

nghiên cứu động học quá trình mài. Hình 3.1 cho thấy rõ các thông số của sơ đồ động học quá 

trình mài.  

 

 

 

 

 

 

 

 

 

Đá mài với đường kính dc quay với vận tốc υc, phôi chuyển động với vận tốc υf, chiều 

sâu cắt a, chuyển động cắt tạo ra các lực tiếp tuyến Ft, lực pháp tuyến Fn và công suất mài có 

ích P. Chiều dài cung tiếp xúc le phụ thuộc vào cả động học và sự tiếp xúc cơ học của quá trình 

mài. Nếu sự biến dạng của đá và phôi trong quá trình mài được bỏ qua thì thông lượng nhiệt đi 

vào vùng mài sẽ tập trung và kết quả đo sẽ được đánh giá cao. Như vậy, sơ đồ động học trong 

quá trình mài (Marinescu et al, 2004) được sử dụng để tính toán chiều dài cung tiếp xúc trong 

quá trình mài. 

2

*

8 r c
e c

c p

R Pd
l ad

E v a
   

                                             (3.1) 

 

Fn

f Ft

le

a

c

dc



Hình 3.1. Sơ đồ động học quá trình mài phẳng 
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Trong đó, Rr là hệ số độ nhám bề mặt xác định bởi hệ số của nhám trên chiều dài cung 

tiếp xúc (Marinescu et al, 2004) và  là hệ số lực được xác định bởi: 

t

n

F

F
   

(3.2) 

 

Và E
*
 là modun đàn hồi tương đương của đá mài và phôi được xác định như sau: 

2 2

*

1 11 f c

f c

v v

E E E

 
   

                                                         (3.3) 

 

Trong đó:  

υ - Hệ số Poisson 

Ef- Modun đàn hồi của phôi. 

Ec - Modun đàn hồi của đá mài. 

Phương trình 3.1 cho thấy, chiều dài cung tiếp xúc le phụ thuộc vào nhiều yếu tố như : 

Công suất P, chiều rộng mài ap, đường kính đá mài và chiều sâu cắt a. Dựa vào công thức 3.1 

có thể tính toán biểu diễn được mối quan hệ giữa le và a như ở hình 3.2.  

 

Hình 3.2. Ảnh hưởng của chiều sâu cắt đối với chiều dài cung tiếp xúc 
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Từ hình 3.2 có thể thấy rõ ràng rằng khi chiều sâu cắt tăng lên thì chiều dài cung tiếp 

xúc cũng tăng lên. Vận tốc cắt cũng ảnh hưởng tới chiều dài cung tiếp xúc. Tuy nhiên ảnh 

hưởng của vận tốc cắt nhỏ hơn ảnh hưởng của chiều sâu cắt a. 

Lượng bóc tách vật liệu trong một đơn vị thời gian Q được gọi là tốc độ bóc vật liệu, 

được xác định như sau: 

f pQ av a  (3.4) 

Trong đó:  

υf – Vận tốc của chi tiết (mm/min). 

ap– Chiều rộng mài (mm). 

a – Chiều sâu cắt (mm). 

Các mối quan hệ động học trong quá trình mài là những thành phần thiết yếu để hình 

thành nên các mô hình tính toán mô phỏng nhiệt cắt của quá trình mài một cách chính xác. 

3.1.2. Xây dựng mô hình tính nhiệt trong quá trình mài phẳng 

Năng lượng mài chủ yếu chuyển thành nhiệt tại vùng tiếp xúc giữa đá và chi tiết gia 

công.  

 

 

 

 

 

 

 

 

 

 

Thông lượng nhiệt toàn phần qt  được phân chia đến phôi gia công là qf  và qc là năng 

lượng vào đá mài, qs là năng lượng thoát ra ngoài bởi dung dịch trơn nguội và qua phoi là qch. 

Hình 3.3. Sơ đồ phân bố thông lượng nhiệt trong quá trình mài 
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Thông lượng nhiệt toàn phần là tỷ số của công suất mài có ích P cung cấp cho trục chính trên 

một đơn vị diện tích tiếp xúc ap.le. 

.

. .

t c
t

p e p e

F vP
q

a l a l
   

(3.5) 

Trong đó: 

ap – Chiều rộng mài (mm);  

le – Chiều dài cung tiếp xúc (mm); 

Ft – Lực mài tiếp tuyến (N); 

υc – Vận tốc của đá mài (m/s) 

qt = qf + q s + q ch + q c  (3.6) 

Một thông lượng nhiệt có thể được biểu thị như một hệ số đối lưu nhiệt h và một nhiệt 

độ T. 

Thông lượng nhiệt truyền đến phôi gia công: qf = hf. Tmax                    (3.7) 

Thông lượng nhiệt truyền đến đá mài:  qc = hc. Tmax         (3.8)                                           

Thông lượng nhiệt truyền đến dung dịch tưới nguội: qs = hs. Tmax                  (3.9) 

Thông lượng nhiệt truyền đến phoi: q ch = h ch. Tmp                                  (3.10) 

Thông lượng nhiệt truyền vào phôi có thể được biểu thị trong điều kiện nhiệt tối đa trên 

bề mặt tiếp xúc như: 

max

f e
f

f

l
q T

C v


  

                                                       (3.11) 

 

Hệ số phôi đối lưu được suy ra là:  

f f

f

e

v
h

C l


  

(3.12) 

Trong đó:  

C - hệ số hiệu chỉnh phụ thuộc vào số tham biến Peclet có thể được tính gần đúng như 

sau (Rowe,2001): 
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Nếu Pe >10 thì C = 1.06 

Nếu 0.2 <Pe < 10 thì 
0.95

2
2

eP
C 


                                                   (3.13) 

Nếu Pe < 0.2 thì C = 0.76 

Hệ số Peclet Pe là một hệ số không thứ nguyên quan trọng được sử dụng để mô tả quá 

trình mài. Nó liên quan đến sự đối lưu cưỡng bức của một hệ thống để truyền nhiệt (Incropera 

và Dewitt, 2002) và được xác định như sau (Rowe, 2001): 

4

f e

e

v l
P


  

(3.14) 

Trong đó:  – Hệ số khuếch tán nhiệt của phôi, được xác định theo công thức sau:  

.
f

c






 
  
 

 
(3.15) 

Về cơ bản, sự đối lưu cưỡng bức của quá trình mài chính là lưu lượng khối lượng các 

phoi thoát ra khỏi vùng mài trong khi đó sự truyền nhiệt của quá trình mài lại là sự truyền 

nhiệt đến phôi và đá mài. 

f - Hệ số đặc tính nhiệt của vật liệu.  

 . .f
f

c    
(3.16) 

 

λ - Hệ số dẫn nhiệt của phôi (W/m.K);  

 - Khối lượng riêng của phôi (Kg/m
3
);  

c - Nhiệt dung riêng của phôi (J/kg.K); 

Nhiệt phát sinh trong phoi tăng đến một giá trị nằm giữa nhiệt độ biến dạng và điểm 

nóng chảy. Nó có thể không cao hơn điểm nóng chảy. Do đó, nhiệt của các điểm nóng chảy 

Tmp khoảng 1250
0
C. Thông lượng nhiệt thoát ra ngoài qua phoi là: 

. . . .
f

ch mp

e

v
q T c a

l
  (3.17) 

 



 - 65 - 

 

 

 

Phôi và các hạt mài tiếp xúc có thể coi như một hệ thống con. Hệ thống này chia sẻ một 

thông lượng nhiệt là: 

fc f cq q q   (3.18) 

Việc phân vùng nhiệt giữa phôi và đá được đánh giá bằng việc sử dụng các khái niệm 

Hahn của một hạt mài trượt trên phôi. Phân vùng năng lượng giữa phôi và đá được xác định 

như sau: 

1

0

0.97
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f f g
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f c f c f c

q h k
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q q h h r v



 
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    

 

(3.19) 

Trong đó:  

kg - Hệ số dẫn nhiệt của các hạt mài; 

r0 – Hệ số ảnh hưởng của sự mài mòn bán kính của các hạt mài. 

Do vậy, hệ số nhiệt đối lưu nhiệt của đá mài tính theo công thức sau:  

1
1c f

f

h h
R

 
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  

 
(3.20) 

Nhiệt độ tối đa Tmax trong vùng mài có thể được ước tính từ các giá trị của hệ số đối lưu 

tính theo các công thức trên. Do vậy, nhiệt độ tối đa Tmax tại vùng mài được xác định như sau: 

ax
t ch
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f
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f

q q
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h
h

R






 
                                                             

(3.21) 

Trong đó:  

hs  -Hệ số nhiệt đối lưu của dung dịch trơn nguội.  

Trong điều kiện mài khô và bôi trơn tối thiểu thì hệ số nhiệt đối lưu của dung dịch trơn 

nguội là không đáng kể. hs = 0 290000W/m
2
K đối với dung dịch trên nền nước. Nó phụ 

thuộc vào loại dung dịch và hiệu quả của việc tưới nguội. Hệ số hs có thể được tính gần với giả 

thuyết theo công thức sau: 
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(3.22) 

 

3.1.3. Xây dựng mô hình truyền nhiệt giữa bề mặt tiếp xúc và bề mặt sau gia công 

Vùng tiếp xúc trong mài được biểu diễn như một nguồn nhiệt cung tròn, hình 3.4. 

Nguồn nhiệt trên bề mặt mài có thể được xem như một tập hợp của vô số các dòng nhiệt 

chuyển dịch được sắp đặt xung quanh một cung tròn có bán kính R, đồng thời nó cũng tạo nên 

một nguồn nhiệt liên tục. 

 

 

 

 

 

 

 

 

 

Mỗi dòng nhiệt chuyển dịch được coi là có hiệu quả theo hướng trục y dài vô hạn và vi 

phân đối với chiều rộng của cung tròn. 

Dòng nhiệt được đặt trong một hệ tọa độ di động x’z’ mà nó chuyển dịch với vận tốc vs 

như trong hình 3.4. Góc tiếp xúc   biến thiên từ 0 đến 2, giá trị thực của i là . Một nguồn 

dòng đơn, dli tại điểm F (xi’, z’i) chuyển dịch với vận tốc v. Chiều dài cung BF là li. Nhiệt độ 

tăng tại điểm M (x’, z’) trong phôi, chịu ảnh hưởng của nguồn nhiệt chuyển dịch với chiều 

rộng dli tại điểm F. Sự gia tăng nhiệt độ tức thời sau thời gian t có thể được phát triển từ giải 

pháp đối với nguồn nhiệt dịch chuyển dựa trên cách tiếp cận của Carslaw and Jaeger [15]. 
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          (3.24) 

Trong đó: 

Hình 3.1. Mặt phẳng cung tiếp xúc trong quá trình mài phẳng [8] 
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'''' iii zzxxr   (3.25) 
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x z i

l
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R
      

(3.26) 

Trong đó: - Hệ số khuếch tán nhiệt và λ –Hệ số dẫn nhiệt của phôi. 

Hàm λt  được định nghĩa như sau: 
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(3.27) 

Trong đó: 
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(3.28) 

Và 
.4

.2 tv
p   là giới hạn trên của biến lấy tích phân . 

Nhiệt độ gia tăng tại điểm M (x’, z’) toàn bộ chiều dài le, được đánh giá bằng cách tích 

phân phương trình 3.24 dọc theo chiều dài của nguồn nhiệt. 
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(3.29) 

Trong đó thông lượng nhiệt q được xác định như sau:  
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   

 
 

(3.30) 

Nếu n = 0 tương ứng với dòng nhiệt đồng nhất 

Nếu n = 1 ứng với dòng nhiệt hình tam giác 

q  là giá trị trung bình của thông lượng nhiệt đối với bề mặt tròn của cung AFB như 

trong hình 3.3. 

Phương trình 3.29 có thể biểu thị dưới dạng không thứ nguyên khi đặt: 

'.4

'.



xv
X  ; 

'.4

'.



zv
Z  ; 

.

4.

ev l
L


  
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Suy ra: 
. .

2. .

v
T

q

 


                                                                                     

(3.31) 

Phương trình 3.29 cung cấp nhiệt độ dọc theo bề mặt tiếp xúc AFB và dọc theo bề mặt 

sau gia công BC. 

Phương trình 3.29 cũng là lời giải gần đúng, trong đó thời gian mài được giả định là 

tương đối ngắn. Lời giải này sẽ đạt tới giá trị ổn định khi Lp lớn hơn rất nhiều so với chiều dài 

cung tiếp xúc. Điều này phụ thuộc vào giá trị của số Peclet L, trong đó: 

.c

e

v a p
L

l L
   

(3.32) 

  

Dựa vào công thức tính toán (3.29) đến (3.31) có thể biểu diễn được trạng thái phân bố ổn định 

của nhiệt độ (không thứ nguyên)  trong vùng mài. Dựa theo kết quả tính toán biểu diễn ở hình 3.5, có 

thể thấy rõ rằng với giá trị L = 50 thì nhiệt độ (không thứ nguyên) của cả mặt tiếp xúc và mặt không 

gia công đều giảm đi khi góc tiếp xúc φ tăng lên. 

 Hình 3.5 cũng cho thấy rõ rằng nhiệt độ tại mặt sau gia công luôn thấp hơn nhiệt độ của mặt tiếp xúc.  

3.2. Mô phỏng nhiệt trong quá trình mài phẳng thép ШХ15 bằng đá mài CBN 

3.2.1. Vật liệu và máy thí nghiệm 

3.2.1.1. Vật liệu chi tiết gia công 
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Hình 3.5. Nhiệt độ tại mặt tiếp xúc và mặt sau gia công [8] 
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Vật liệu nghiên cứu là thép ШX15 nhiệt luyện đạt độ cứng HRC = 58 ÷ 60. Bảng 3.1 và 

3.2 là tỷ lệ các nguyên tố (theo %) của thép ШX15 và kí hiệu mác thép tương đương với thép 

ШX15 của các nước.     

    Bảng 3.1. Tỷ lệ các nguyên tố của thép ШX15. 

Tỷ lệ các nguyên tố (%) 

C Mn Si Cr Ni Cu S P 

0,95÷1,05 0,2÷0,4 0,17÷0,37 1,30÷1,65 0,3 0,25 0,2 0,27 

 

Bảng 3.2. Thông số lý tính của thép ШX15. 

λ = 25W/m.K  ρ = 7700 kg/m
3 

 с = 460J/kg.K 

 

 Bảng 3.3. Kí hiệu tương đương mác thép ШX15 của các nước. 

Việt Nam 

(TC VN) 

Nga 

(TC OCT) 

Mỹ 

(TC SAE) 

Nhật 

( TC JIS) 

OL 100Cr 1,5 ШX15 52100 SUJ2 

 

Thép ШX15 được sử dụng phổ biến để chế tạo các chi tiết chính xác và chịu mài mòn 

như vòng bi, vít me bi, bạc, đĩa ma sát… 

3.2.1.2. Đá mài 

Đá mài CBN của hãng EHWA (Korea) có kí hiệu: 

                           RB- 1A1, 250D-20T-2X-75H, SL80N100BI 

Các thông số cơ bản của đá là: 

RB - vật liệu hạt mài là CBN. 

1A1 - kiểu đá mài. 

250D - đường kính ngoài của đá mài. 

20T - bề rộng của đá mài. 

2X - chiều dày lớp hạt mài CBN. 

75H - đường kính lỗ của đá mài. 
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SL - kí hiệu riêng của nhà sản xuất. 

80 - độ hạt ( số mắt sàng có trong một tấc Anh). 

N - độ cứng của đá mài. 

100 - nồng độ hạt mài (trong 1mm
3
 đá mài CBN có 0,878 mg hoặc 0.00439 cara hạt 

mài CBN). 

BI - chất dính kết là nhựa tổng hợp. 

3.2.1.3. Máy thí nghiệm 

Thí nghiệm trên máy mài phẳng 3Б725, các đặc tính kỹ thuật chính của máy: 

- Công suất động cơ trục chính : 2,8 kw. 

- Số vòng quay của trục đá mài : 2860 vòng/ph. 

- Tốc độ chuyển động dọc của bàn máy : 0 ÷ 22 (m/ph). 

- Chạy dao ngang của bàn máy/1 hành trình dọc của bàn máy: 0,2 ÷ 2 (mm). 

3.2.2. Mô phỏng truyền nhiệt khi mài phẳng thép ШХ15 bằng đá mài CBN 

Các mô hình số được sử dụng để ước tính nhiệt độ trong vùng tiếp xúc trong quá trình 

mài. Các thông số của mô hình nhiệt trong vùng tiếp xúc được xác định từ các mô hình truyền 

nhiệt trong quá trình mài, sau đó được thiết lập trong ANSYS 10.0 và cho chúng ta có một 

cách tiếp cận nhiệt một cách chính xác hơn. 

Sơ đồ quá trình thực hiện mô phỏng được thực hiện như sau: 

 

 

 

 

 

 

 

 

 

Thông lƣợng nhiệt: 

-  Thông lượng nhiệt toàn phần qt:   

321 KKKvFq CC   

- Thông lượng nhiệt vào chi tiết qf: 

t
f

e

q
q

a l
  

Các thông số vào: 

- Vận tốc đá mài υc 

- Vận tốc chi tiết υf 

- Chiều sâu cắt a 

- Lực cắt Fc 

 

Mô hình nhiệt phân tích bằng 

phƣơng pháp phần tử hữu hạn 

(FEM) 

Tmod 
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 Mô hình chi tiết mô phỏng có kích thước 250x150x20 mm được biểu diễn như hình 3.5. 

l
e

a p

q

v
f

, c, 



 

Hình 3.7. Mô hình phôi mô phỏng trên ANSYS 10.0 

3.2.2.1. Thông lƣợng nhiệt truyền vào chi tiết gia công qf 

Theo [17] ta có thể xác định thông lượng nhiệt toàn phần qt theo công thức sau: 

1 2 3t C Cq F v K K K  (3.34) 

Trong đó:  

 Fc – Lực cắt (N) 

 υc – Vận tốc của đá mài (m/s) 
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K1 – Hệ số điều chỉnh để xác định công suất khi mài chuyển thành nhiệt, theo [17] thì 

K1=0.8 

K2 – Hệ số phân bố nhiệt vào chi tiết gia công, theo [17] thì K2=0.9 

K3 – Hệ số phân bố nhiệt vào chi tiết gia công và truyền qua phoi, được xác định theo 

công thức sau:  

3

1

4
1

f

e p

K
v

a
l a





 
(3.35) 

Trong đó: 

 a – Chiều sâu cắt (mm) 

 υf – Vận tốc của chi tiết gia công (mm/min) 

 ap – Chiều rộng khi mài (mm) 

 le – Chiều dài cung tiếp xúc khi mài, được xác định theo công thức 3.1. 

Thông lượng nhiệt truyền vào chi tiết gia công được xác định theo công thức: 

t
f

e

q
q

a l
  

(3.36)                                                                                                                                                                                                                                                                               

  

Từ phương trình 3.36 có thể tính toán xác định được quan hệ giữa thông lượng nhiệt truyền 

vào chi tiết gia công ứng với các chiều sâu cắt khác nhau. Các kêt quả tính toán này được thể 

hiện ở hình 3.7. 

 

 

 

 

 

 

 

Hình 3.8. Mối quan hệ giữa thông lượng nhiệt và chiều sâu cắt 
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Hình 3.8 cho thấy khi chiều sâu cắt tăng lên thì thông lượng nhiệt truyền vào chi tiết gia 

công cũng tăng lên tương ứng. Hiện tượng này cũng gắn liền với sự tăng lên của lực cắt khi 

mài. Tuy nhiên có một điều lý thú là vận tốc cắt có tác động ngược lại lên thông lượng nhiệt. 

Khi vận tốc cắt tăng lên sẽ dẫn đến lực cắt giảm đi cũng như thông lượng nhiệt giảm đi. Đây 

cũng là cơ sở lý thuyết của mài cao tốc, giúp tăng năng suất khi mài. 

3.2.2.2. Hệ số khuếch tán nhiệt của chi tiết gia công α 

Hệ số khuếch tán nhiệt là một tham số để ước tính tỉ lệ truyền nhiệt giữa nguồn nhiệt và 

vật hấp thụ nhiệt. Hệ số này là một thông số quan trọng trong nghiên cứu truyền nhiệt nói 

chung và trong các nghiên cứu về nhiệt mài nói riêng. Hệ số này phụ thuộc số Reynold (Re), 

số Prandtl (Pr) và được xác định theo hàm Nusselt (Incropera và Dewitt, 2002): 

Hàm Nussel
 /.

/

dT dsd
Nu

T d






 


                                                            

(3.37)  

0.8

0.1 2/3

0.037 Re Pr

1 2.443Re (Pr 1)
Nu




   

(3.38)  

Khi thay các giá trị của số Pr và Re thì giá trị hàm Nussel có giá trị là 

 Nu = 3645. Thay vào  công thức 3.38 ta có:   = 4775W/m
2
.s. 

3.2.2.3. Thời gian tác động của nguồn nhiệt tw 

Thời gian tác động của nguồn nhiệt tw cho ta thấy rõ ràng tốc độ di chuyển của thông 

lượng nhiệt trên chiều dài cung tiếp xúc. Xác định chính xác được tham số này cho ta xác định 

được thời điểm xảy ra những tổn hại về nhiệt truyền trong chi tiết gia công ứng với các thông 

số công nghệ khác nhau. Nó được xác định theo phương trình 3.39. 

w1 w 2

w

mod w w w w w( , )

e

f

B B

l
t

v

T f q t A q t



 

 

(3.39) 
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 Kết quả tính toán thông lượng nhiệt như là một hàm của thời gian tác động, nguồn 

nhiệt, vận tốc chi tiết gia công vf và chiều sâu cắt a được thể hiện ở hình 3.9.  

 

T

ừ hình 

3.9 có 

thể rút 

ra các 

nhận 

xét 

như 

sau: 

-

 Khi 

vận 

tốc chi tiết gia công cũng như chiều sâu cắt tăng lên thì thông lượng nhiệt sẽ tăng lên.  

- Thông lượng nhiệt chuyển di chuyển rất nhanh trong khoảng thời gian rất ngắn. Điều 

này rất có ý nghĩa đối với quá trình mài thực tế do mỗi loại vật liệu khi mài chỉ có thể tiếp 

nhận được một lượng nhiệt truyền vào nhất định trong một khoảng thời gian xác định. Mặt 

khác đối với mỗi vật liệu khác nhau thì đều có các nhiệt độ chuyển biến pha và khả năng hấp 

thụ nhiệt. Do vậy, nếu vượt quá giới hạn nói trên sẽ dẫn đến sự thay đổi cấu trúc pha austennit 

và gây ra những tổn hại nhiệt cho chi tiết gia công. 

- Các đặc tính vật lý của vật liệu chi tiết gia công là rất quan trọng trong quá trình này 

như: nhiệt dung riêng, hệ số khuếch tán nhiệt, ...đảm bảo cho sự dẫn nhiệt ở các lớp vật liệu 

dưới lớp bề mặt tiếp xúc. 

3.2.2.4. Mô phỏng quá trình truyền nhiệt 

Mục tiêu của mô hình hóa quá trình truyền nhiệt ở bề mặt tiếp xúc trong quá trình mài 

thép ШХ15, là để xác định nhiệt độ tối đa trên bề mặt tiếp xúc cũng như thông lượng nhiệt 

truyền xuống các lớp tiếp theo trên bề mặt chi tiết gia công, từ đó xác định khả năng xảy ra các 

Hình 3.9. Quan hệ giữa thông lượng nhiệt và thời gian tác động của nguồn nhiệt 
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tổn hại về nhiệt đối với lớp bề mặt chi tiết. Xây dựng chương trình mô phỏng thực hiện theo 

trình tự sau: 

- Mô hình hình học của chi tiết gia công có kích thước 250x150x20mm như trên hình 

vẽ 3.5, chọn dạng phôi đối xứng để giảm thời gian xử lý số liệu của máy tính mà vẫn đảm bảo 

tính chính xác của các kết quả cần đạt được. 

- Các đặc tính vật lý của phôi cũng như các thành phần hóa học được chỉ ra trong bảng 

3.1và bảng 3.2. 

- Thiết lập dạng lưới kiểu phần tử khối SOLID90, với 20 điểm nút, phần tử nhiệt 

(SOLID90 – 3D,20 Nod thermal Solid). 

- Thiết đặt tải ban đầu (môi trường làm mát, nhiệt của chất làm mát...). 

- Thiết lập các điều kiện biên (chiều dài cung tiếp xúc, thông lượng nhiệt vào chi tiết 

gia công, diện tích tiếp xúc). 

- Xây dựng quy trình mô phỏng, xác định các kết quả (Các lĩnh vực nhiệt, nhiệt độ tối 

đa trên bề 

mặt). 

Khi 

thực hiện 

các bước 

cho quá 

trình mô 

phỏng thì ta 

nhận được 

kết quả 

phân bố 

nhiệt như 

trong hình 

3.10. 
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Từ kết quả của quá trình mô phỏng ta có thể biểu diễn được mối quan hệ giữa nhiệt độ 

bề mặt với chiều sâu cắt và vận tốc chi tiết gia công như ở hình 3.11.  

Qua hình vẽ 3.11 cho thấy: khi chiều sâu cắt cũng như vận tốc chi tiết gia công tăng lên 

thì nhiệt độ bề mặt tăng lên. Ảnh hưởng của chiều sâu cắt gắn liền với sự tăng lên của lực cắt. 

Ảnh hưởng của vận tốc phôi gắn liền với 2 yếu tố đó là sự tăng lên của lực cắt và thời gian tác 

động ngắn. 

Nhiệt độ bề mặt trong quá trình mô phỏng có thể biểu diễn dưới dạng là một hàm của 

thông lượng nhiệt qf và thời gian tác động tw, được xác định theo công thức sau: 

w1 w 2

mod w w w( , )
B B

f fT f q t A q t   (3.40) 

Trong đó, các hệ số Aw, Bw1, Bw2 được xác định nhờ vào quá trình mô phỏng, kết quả 

xác định các hệ số này được thể hiện ở bảng sau: 

Aw Bw1 Bw2 

127,67365 0,6526478 0,173 

 

Từ kết quả xác định các hệ số này có thể thấy rõ ràng ảnh hưởng của thông lượng nhiệt 

lên nhiệt độ bề mặt lớn hơn ảnh hưởng của thời gian tác động lên nhiệt độ bề mặt. 

Hình 3.11. Mối quan hệ giữa nhiệt độ bề mặt với chiều sâu cắt và vận tốc phôi 
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Kết quả của quá trình mô phỏng cũng cho biểu diễn được mối quan hệ giữa nhiệt độ bề 

mặt với chiều sâu cắt ở các vận tốc cắt khác nhau như ở hình 3.12. 

Hình 3.12 cho thấy khi chiều sâu cắt tăng lên thì lực cắt tăng lên và nhiệt độ bề mặt 

cũng tăng lên. Trong khi đó khi vận tốc cắt tăng lên thì lực cắt giảm đi và dẫn đến nhiệt độ bề 

mặt giảm đi.  

3.3. Kết luận chƣơng 3 

1. Đã xây dựng được mô hình tính thông lượng nhiệt trong quá trình mài phẳng. Mô 

hình cho phép đánh giá mức độ ảnh hưởng của các thông số công nghệ cũng như các đặc tính 

vật lý của vật liệu đá mài, phôi và dung dịch trơn nguội đến thông lượng nhiệt trong quá trình 

mài.  

2. Đã xây dựng được mô hình toán xác định được thông lượng nhiệt trên bề mặt tiếp 

xúc truyền đến bề mặt sau gia công và là cơ sở để xác định khả năng truyền nhiệt của vật liệu 

gia công trong quá trình mài phẳng. Mô hình này làm cơ sở cho quá trình mô phỏng truyền 

nhiệt khi sử dụng phương pháp phần tử hữu hạn bằng phần mềm ANSYS 10.0. 

3. Mô phỏng được sự truyền nhiệt khi mài thép ШХ15 bằng đá mài CBN bằng phần 

mềm ANSYS 10.0. Đánh giá được ảnh hưởng của tốc độ cắt, vận tốc phôi và chiều sâu cắt đến 

Hình 3.12. Mối quan hệ giữa nhiệt độ bề mặt với chiều sâu cắt và vận tốc cắt 
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nhiệt độ bề mặt của chi tiết khi mài. Đây là các kết quả rất quan trọng nó giúp cho tối ưu hóa 

quá trình mài thông qua việc điều khiển các thông số của quá trình mài . 

 

 

 

 

 

 

 

 

 

 

KẾT LUẬN CHUNG 

1. Nhiệt cắt trong quá trình mài làm ảnh hưởng tới chất lượng bề mặt chi tiết gia công 

như làm thay đổi ứng suất dư, gây cháy nứt, thay đổi cấu trúc tế vi lớp bề mặt... 

2. Các thông số công nghệ đều ảnh hưởng tới nhiệt cắt trong quá trình mài với mức độ 

khác nhau trong đó chiều sâu cắt và vận tốc cắt có ảnh hưởng lớn nhất. Như vậy, trong quá 

trình mài cần đặc biệt ưu tiên điều chỉnh các thông số này. 

3. Các mô hình toán để mô phỏng quá trình truyền nhiệt trong quá trình mài phẳng cũng 

được đề cập. Mô hình này là cơ sở cho để nghiên cứu về nhiệt cắt trong các quá trình mài khác 

như mài tròn ngoài.... 

4. Xây dựng chương trình mô phỏng nhiệt trong quá trình mài cho phép đánh giá được 

những vùng nhiệt và là cơ sở để điều khiển quá trình mài để hạn chế những tổn hại về nhiệt 

đối với bề mặt chi tiết gia công. Nó kết hợp với các nghiên cứu thực nghiệm về nhiệt mài để 

cho ta những hiểu biết hoàn thiện hơn về tổn hại nhiệt trong quá trình mài. 

* Hƣớng nghiên cứu tiếp theo: 



 - 79 - 

 

 

 

1. Có thể đi sâu nghiên cứu ảnh hưởng của các thông số công nghệ đến nhiệt cắt trong 

quá trình mài nói chung cũng như trong mài phẳng nói riêng. Từ đó tối ưu hoá các thông số 

này về nhiệt trong quá trình mài, tránh hiện tượng cháy bề mặt khi mài. 

2. Đề tài này có thể phát triển thêm theo hướng xây dựng một mô hình mài an toàn 

nhiệt tránh hiện tượng cháy bề mặt như ở hình 3.13. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Thông lƣợng nhiệt: 

-  Thông lượng nhiệt 

toàn phần qt:   

321 KKKvFq CC 

- Thông lượng nhiệt 

vào chi tiết qf: 

t
f

e

q
q

a l
  

Hệ số khuếch tán 

nhiệt của chi tiết gia 

công α 

e

Nu

l


   

Kiểm tra điều kiện: 

Tmod  > Tgrenz 

 

Các thông số vào: 

- Vận tốc đá mài υc 

- Vận tốc chi tiết υf 

- Chiều sâu cắt a 

- Lực cắt Fc 

 

Mô hình phân tích nhiệt 

bằng phương pháp phần tử 

hữu hạn (FEM) 

Tmod 

Hình 3.13. Sơ đồ mô hình hóa quá trình mài phẳng 

Nhiệt độ tới hạn: 

Tgrenz 

 

Kiểm tra điều kiện: 

Tmod  < Tgrenz 

Quá trình mài phẳng đạt 

yêu cầu 
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Thông qua thực nghiệm có thể xác định được nhiệt độ tới hạn Tgrenz mà khi nhiệt độ bề 

mặt chi tiết khi mài lớn hơn nhiệt độ này sẽ xảy ra hiện tượng cháy bề mặt như ở hình 3.1.4. 

Khi nhập nhiệt độ tới hạn này vào chương trình mô phỏng nhiệt khi mài có thể xác định 

được 

miền 

các 

thông số 

công 

nghệ an 

toàn 

đảm bảo 

không 

xảy ra 

hiện tượng cháy bề mặt khi mài.  
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